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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-

tions de ce chapitre. Pour une liste plus détaillée, voyez I'Aide de I'application.

Windows ou Linux

Equivalent Mac

Effet

Sélection du menu
Outils > Options

LibreOffice > Préférences

Acceés aux options de configuration

Clic droit

Control+clicouclic
droit selon la configuration
de l'ordinateur

Ouvre un menu contextuel

Ctrl (Control)

(Command )

Utilisé avec d’autres touches

F5

Shift+Eg+F5

Ouvre le Navigateur

Fi1

g +T

Ouvre la fenétre Styles et Formatage
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Qu’est-ce que Calc ?

Calc est le module tableur de LibreOffice. Vous pouvez saisir des données (ordinairement numé-
rigues) dans un classeur puis les manipuler pour produire certains résultats.

Vous pouvez aussi saisir les données puis utiliser Calc dans un mode « Et si ? » en modifiant cer-
taines de ces données pour observer le résultat sans avoir a retaper la feuille ou le classeur en
entier.

Parmi les autres fonctionnalités de Calc, on trouve :

» Des fonctions qui peuvent servir a créer des formules pour effectuer des calculs complexes
sur les données.

* Des fonctions de base de données pour trier, stocker et filtrer les données.

» Des graphiques dynamiques : une large gamme de diagrammes en 2D et 3D.

» Des macros pour enregistrer et exécuter les taches répétitives ; parmi les langages de
script supportés, on trouve LibreOffice Basic, Python, BeanShell et JavaScript.

* La capacité a ouvrir, modifier et enregistrer les classeurs de Microsoft Excel.

* Limportation et I'exportation de classeurs dans de nombreux formats, parmi lesquels
HTML, CSV, PDF et PostScript.

“ Remarque

Si vous désirez utiliser dans LibreOffice des macros écrites dans Microsoft Excel avec
le code de macro VBA, vous devez d’abord éditer le code dans I'EDI de LibreOffice
Basic. Voyez le Chapitre 13, Débuter avec les macros et le Guide Calc, Chapitre 12,
Les macros de Calc.

Classeurs, feuilles de calcul et cellules

Calc travaille avec des éléments appelés classeurs. Un classeur est constitué de plusieurs feuilles
de calcul individuelles, contenant chacune des cellules disposées en lignes et en colonnes. Une
cellule donnée est identifiee par son numéro de ligne et la lettre de sa colonne.

Les cellules contiennent les éléments particuliers — textes, nombres, formules, etc. — qui consti-
tuent les données a afficher et a manipuler.

Chaque classeur peut posséder plusieurs feuilles de calcul et chaque feuille peut posséder plu-
sieurs cellules individuelles. Dans Calc, chaque feuille de calcul peut avoir au maximum 1 048 576
lignes (65 536 dans Calc 3.2 et précédents) et 1 024 colonnes. LibreOffice Calc peut gérer jusqu’a
32 000 feuilles.

La fenétre principale de Calc

Quand Calc démarre, la fenétre principale s'ouvre (Figure 1). Les éléments de cette fenétre sont
décrits ci-dessous.

e Remarque

Si une partie de la fenétre de Calc (Figure 1) n’apparait pas, vous pouvez l'afficher en
utilisant le menu Affichage. Par exemple, Affichage > Barre d’état va basculer (affi-
cher ou masquer) la barre d'état. |l n'est pas toujours nécessaire de tout afficher,
comme sur la Figure 1; affichez ou masquez ce que vous voulez.

La fenétre principale de Calc | 9



Barre Barre de Barre d'outils Barre doutils
de titre menu standard formatage

B Sans nom 1 - LibreOffic » Calc

Fichier Edition Affichale Insertion Formgk Feuille Données Outild Fenétre  Aide
a i aq Y = % @ = & = B ] 1 ] —_—
B EBat KRR ¢S Al TE=E P MK Ek -
Liberation Sans vl v @ [ S - .E. - A === = Et =t =4 - % 0.0 j L‘;‘L'}, -
A1 | fx Z = - Propriétés L
\ C | D * | F G E Styles - =
- \ Par défaut k-0 &
B
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g Cell_ule Reterence tje la  Barre de En-téte de Liberation Sans 0 FBE
2| active cellule active formule colonne @
8 (boite de nom) G [ S v i 12
9 fx
10 A - ® e
11 -
12 e En-téte de Volet - Format numérique =
12 i ’
14 ligne lateral |Standarcl v b %L
15
’IE v | Mombre de décimales  Zéros non significatii
€ ¥ | -
+ | Feyllet =) ! v
Feudle 1 sur 1 Par difaut w | Moyenne: ; Somme; 0 . F | 100 %

| t

Onglet de Barre
feuille de calcul d'état

Figure 1 : La fenétre principale de Calc

La barre de titre

La barre de titre, située tout en haut, affiche le nom du classeur ouvert. Quand il vient d'étre créé,
a partir d'un modéle ou d’'un document vide, son nom est Sans nom X, ou X est un nombre. Quand
vous enregistrez le classeur pour la premiére fois, vous étes invité a lui donner le nom de votre
choix.

La barre de menu

La barre de menu est I'endroit ou vous sélectionnez un des menus et divers sous-menus appa-
raissent pour vous donner plus de choix. Vous pouvez aussi personnaliser la barre de menu :
voyez le Chapitre 14, Personnaliser LibreOffice pour plus d'informations.

* Fichier — contient les commandes qui s'appliquent a la totalité du document ; par exemple
Ouvrir, Enregistrer, Assistants, Exporter au format PDF, Imprimer, Signatures humeériques.

« Edition — contient les commandes pour I'édition du document ; par exemple Annuler,
Copier, Suivi des modifications, Plug-in, etc.

» Affichage — contient les commandes pour modifier 'apparence de linterface utilisateur de
Calc ; par exemple Barres d’outils, En-téte de colonnes/lignes, Plein écran, Zoom, etc.

* Insertion — contient les commandes pour insérer des éléments dans un classeur ; par
exemple Image, Cadre, Diagramme, Fonctions, Caractéres spéciaux, etc.

* Format — contient les commandes pour modifier 'agencement d’'un classeur ; par exemple
Cellules, Page, Aligner, Formatage conditionnel, etc.

* Feuille — contient les commandes pour modifier les éléments de la feuille ; par exemple
Insérer et Supprimer des cellules, des colonnes, des lignes et des feuilles ainsi que des
Commentaires et Remplir les cellules, etc.

10 | Débuter avec Calc



* Données — contient les commandes pour manipuler les données dans votre classeur ; par
exemple Définir la plage, Trier, Statistiques, Table de Pilote, Consolider, etc.

* Outils — contient diverses fonctions pour vous aider a vérifier et a personnaliser votre clas-
seur, par exemple Orthographe, Partager le classeur, Protéger la feuille, Macros, etc.

* Fenétre — contient les commandes pour l'affichage de la fenétre ; par exemple Nouvelle
fenétre, Fermer la fenétre.

* Aide — contient des liens vers le systéme d'aide qui accompagne le logiciel et d'autres
fonctions diverses ; par exemple Aide de LibreOffice, Information de licence, Vérifier les
mises a jour, etc.

Barres d’outils

Dans la disposition par défaut, a I'ouverture de Calc, les barres d'outils Standard et Formatage
sont ancrées en haut de I'espace de travail (Figure 1).

Les barres d’'outils de Calc peuvent étre soit ancrées a une position fixe, soit flottantes ce qui vous
permet de les déplacer a une position plus pratique sur votre espace de travail. Les barres d’outils
ancrées peuvent étre libérées et soit déplacées a une position d’ancrage différente sur I'espace de
travail, soit laissées flottantes. Les barres d’outils qui sont flottantes quand on les ouvre peuvent
étre ancrées a une position fixe sur votre espace de travail.

Vous pouvez choisir une barre d'outils unique a la place des deux barres de la configuration par
défaut. Elle propose les commandes les plus utilisées. Pour I'activer, dans le menu Affichage >
Barre d’outils, sélectionnez Standard (mode simple) et décochez Standard et Formatage.

L'ensemble par défaut des icbnes (parfois appelées boutons) des barres d’'outils offre une grande
variété de commandes et de fonctions courantes. Vous pouvez aussi ajouter ou supprimer des
icbnes des barres d'outils, voyez le Chapitre 14, Personnaliser LibreOffice pour plus d’'informa-
tions.

Placer le pointeur de la souris sur chacune de ces icones fait apparaitre une petite boite, appelée
info-bulle. Elle donne une bréve explication de la fonction de l'icbne. Pour une explication plus
détaillée, choisissez Aide > Qu’est-ce que c’est ? et placez le pointeur de la souris sur I'icone.
Pour désactiver cette fonction, cliguez dessus ou appuyez sur la touche Echap. Les astuces
détaillées (info-ballons) peuvent étre activées ou désactivées depuis Outils > Options >
LibreOffice > Général.

La barre de formule

La barre de formule est située en haut de la feuille de calcul dans I'espace de travail de Calc. Elle
est ancrée de fagon permanente a cette position et elle ne peut pas étre rendue flottante. Si elle
n'est pas visible, sélectionnez Affichage dans la barre de menu et choisissez Barre de formule.

Al "fx2= =

Figure 2 : La barre de formule

De gauche a droite sur la Figure 2, la barre de formule est constituée des éléments suivants :

* La Zone de nom — indique la référence de la cellule actuellement active par une combinai-
son d’'une lettre et d’'un nombre, par exemple Al. La lettre indique la colonne et le nombre
la ligne de la cellule sélectionnée. Si vous avez sélectionné une plage de cellules qui a recu
un nom, celui-ci est affiché dans cette boite. Vous pouvez aussi taper une référence de cel-
lule dans la Zone de nom pour sauter a la cellule référencée. Si vous tapez le nom d’'une
plage nommée et que vous appuyez sur la touche Entrée, la plage nommeée est sélection-
née et affichée.

* ['Assistant Fonctions ﬁ — ouvre une boite de dialogue ou vous pouvez parcourir une
liste des fonctions disponibles. Cette boite peut étre trés utile, car elle indique aussi les
paramétres de ces fonctions.
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* Somme E — en cliquant sur I'icone Somme, on calcule le total des nombres dans les cel-
lules au-dessus de la cellule active et on place le résultat dans celle-ci. S'il n'y a pas de
nombres au-dessus de la cellule active, la somme est effectuée sur celles de gauche.

* Fonction = — cliquer sur I'icdbne Fonction insére un signe égal (=) dans la cellule active et
dans la lighe de saisie, ce qui permet de saisir la formule.

+ Laligne de saisie — affiche le contenu de la cellule active (donnée, formule ou fonction) et
vous permet de modifier son contenu. Pour transformer la ligne de saisie en une zone de
saisie multi-ligne pour les tres longues formules, cliquez sur le bouton de droite.

* Vous pouvez aussi éditer le contenu d’'une cellule directement dans celle-ci en faisant un
double clic sur la cellule elle-méme ou en appuyant sur la touche F2. Quand vous saisissez
une nouvelle donnée, Les icbnes Somme et Fonction sont remplacées par les icones

Annuler et Accepter kR

Le contenu de la cellule courante (donnée, formule ou fonction) est affiché dans la Ligne de sai-
sie, qui est le reste de la barre de formule. Vous pouvez modifier le contenu de la cellule courante
soit ici, soit dans la cellule courante. Pour modifier dans la zone Ligne de saisie, cliquez dans la
zone, puis tapez vos modifications. Pour modifier dans la cellule courante, double-cliquez simple-
ment dans la cellule.

e Remarque

Dans un classeur, le terme « fonction » va bien au-dela des simples fonctions mathé-
matiques. Voyez le Guide Calc, Chapitre 7, Utiliser les formules et les fonctions pour
plus d’informations.

La barre d’état

La barre d'état de Calc (Figure 3) offre des informations sur le classeur ainsi que des moyens
rapides et pratiques pour modifier certaines de ses propriétés. La plupart des champs sont sem-
blables a ceux des autres éléments de LibreOffice : voyez le Chapitre 1, Introduction a LibreOffice
de ce guide et le Guide Calc, Chapitre 1, Introduction a Calc pour plus d’informations.

Numéro Style de Mode de Signature Curseur  Pourcentage
de feuille page sélection numerigue  de zoom de zoom
| Feuille 1 sur 1| 5 lignes, 3 colonnes sélectionnées | Par défaut 5 Moyenne: 1; Somme: 1 100 55-_-|
Information sur les Mode Modifications Informations sur la
cellules sélectionnées d'insertion  non enregistrees cellule ou I'objet

Figure 3 : La barre d’état de Calc

La barre d’'état offre un moyen rapide pour effectuer quelques opérations mathématiques sur les
cellules sélectionnées dans la feuille de calcul. Vous pouvez calculer la moyenne et la somme,
compter les éléments de la sélection et plus encore en faisant un clic droit sur la zone d'informa-
tions sur la cellule dans la barre d'état puis en choisissant les opérations que vous désirez afficher
dans la barre d'état. Depuis la version 5.2, plusieurs opérations peuvent étre affichées simultané-
ment.
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Le volet latéral

Le volet latéral de Calc (Affichage > Volet latéral) (Figure 29) est situé a droite de la fenétre.
C’est un mélange de barre d'outils et de boite de dialogue qui est constitué de cinq pages : Pro-
priétés, Styles et formatage, Galerie, Navigateur et Fonctions. Chacun correspond a une icone
sur le panneau d’onglets a droite du volet latéral qui vous permet de passer de 'un a l'autre.

Configuration du

Propriétés *II = [T volet latéral
= Styles - Barre de titre
Par défaut v B C
[l
=l Caractére L
Onglets
Liberation Sans “1110 |~|] _
&
G / S -~ My i [
Ix
ﬂ -
Contenu de I'onglet
= Format numérique | :
Titre de panneau
|Standard vl Jh - % 0.0
Nombre de décimales Zéros non significatifs
= 11 - Contenu du panneau
Bouton L] Nombres négatifs en rouge
Afficher/ [] Séparateur de milliers
Masquer .
Bouton plus d'options

® Alignement =

Figure 4 : Volet latéral de Calc avec la page Propriétés ouverte.

Les pages sont décrites ci-dessous.

* Propriétés : cette page contient cinq panneaux.

Styles : permet le choix du style de la cellule, son actualisation et la création de nou-
veaux styles.

Caractéres : fournit les contrbles pour formater le texte, par exemple la famille de
police, la taille et la couleur. Certains contréles, comme Exposant, ne sont actifs que si
le curseur de texte est actif dans la Ligne de saisie de la barre de formule ou dans la
cellule.

Format numérique : permet de modifier rapidement le format des nombres (hombre de
décimales, monnaie, dates ou texte numérique). Les contrdles des champs numériques
et étiquettes pour les fiches sont aussi disponibles.

Alignement : fournit les contrbles pour aligner le texte de diverses maniéres, y compris
horizontalement et verticalement, le retour a la ligne, l'indentation, la fusion de cellules,
I'orientation du texte et I'empilement vertical.

Apparence de cellule : offre des contréles pour définir les options d’apparence, y com-
pris la couleur d’arriere-plan et le format des bordures (couleur et style de lignes, grille)
de la cellule.
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Chaque panneau possede un bouton Plus d’options qui ouvre une boite de dialogue
offrant un plus grand nombre d'options. Ces boites de dialogue empéchent I'édition du
document jusqu’a leur fermeture.

+ Styles et formatage : cette page ne contient qu’'un panneau qui est identique a celui qui
s’ouvre grace au bouton Styles et formatage (F11) de la barre d'outils Formatage du
texte.

* Galerie : cette page ne contient qu'un panneau qui est identique a celui qui s’ouvre en cli-
quant sur le bouton Galerie de média dans la barre d'outils Standard ou Affichage >
Galerie dans la barre de menu.

* Navigateur : cette page ne contient qu'un panneau qui est pratiguement le méme que la
fenétre Navigateur qui s’ouvre en cliquant sur le bouton Navigateur dans la barre d’outils
Standard ou en choisissant Affichage > Navigateur (F5) dans la barre de menu. La seule
différence est que le bouton Contenu est absent du panneau du Volet latéral.

* Fonctions : cette page ne contient gu'un panneau qui est le méme que la fenétre qui
s'ouvre par Insertion > Fonction dans la barre de menu.

A droite de la barre de titre de chaque plateau ouvert un bouton Fermer le volet latéral (X) permet
de fermer la page en ne laissant que la barre d’'Onglets ouverte. Cliquer sur l'icbne de n’'importe
guel onglet ouvre de nouveau la page correspondante.

Le Volet latéral peut étre masqué ou affiché, s'il est déja masqué, en cliquant sur le bouton Affi-
cher/Masquer de la bordure. Vous pouvez ajuster la largeur du plateau en tirant sur la bordure
gauche du volet latéral.

Agencement d’un classeur

Cellules individuelles

La partie principale de I'espace de travail de Calc affiche des cellules disposées en grille. Chacune
est placée a l'intersection d’'une colonne et d'une ligne.

Au sommet des colonnes et a gauche des lignes, il y a une série d’en-tétes qui contiennent des
lettres et des nombres. Les en-tétes de colonnes utilisent un caractére alphabétique qui com-
mence a A et continue vers la droite. Les en-tétes de lignes utilisent un caractere numérique qui
débute a 1 et augmente vers le bas.

Ces en-tétes de colonnes et de lignes forment les références des cellules qui apparaissent dans la
Zone de nom de la barre de formule (Figure 2). Si les en-tétes ne sont pas visibles dans votre clas-
seur, sélectionnez Affichage dans la barre de menu et cliquez sur En-tétes de colonnesl/lignes.

Onglets de feuille de calcul

Dans Calc, vous pouvez avoir plusieurs feuilles de calcul dans un classeur. En bas de la grille de
cellule, vous trouverez des onglets qui indiguent le nombre de feuilles que votre classeur contient.
Cliquer sur un onglet donne accés a une feuille particuliére et I'affiche. Un feuille active est indi-
quée par un onglet blanc (dans la disposition par défaut de Calc). Vous pouvez aussi sélectionner
plusieurs feuilles en appuyant sur la touche Ctrl pendant que vous cliquez sur les onglets (Voir
« Sélectionner des feuilles », page 26).

Pour modifier le nom par défaut d'une feuille (Feuille 1, Feuille 2, etc.), faites un clic droit sur I'on-
glet de la feuille et sélectionnez Renommer la feuille dans le menu contextuel, ou double-cliquez
sur 'onglet. Une boite de dialogue s’ouvre ou vous pouvez taper un nouveau nom pour la feuille.
Cliquez sur OK quand vous avez fini pour refermer la boite de dialogue.

Pour modifier la couleur de I'onglet, faites un clic droit sur celui-ci et sélectionnez Couleur d’on-
glet dans le menu contextuel pour ouvrir la boite de dialogue Couleur d’onglet (Figure 5). Choisis-
sez votre couleur et cliquez sur OK quand vous avez fini pour refermer la boite de dialogue. Pour
ajouter de nouvelles couleurs a la palette, voyez le Chapitre 14, Personnaliser LibreOffice pour
plus d’informations.
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Couleur d'onglet

HPar défaut

CHLCEREERERRCRE
BOCEEEERERECEE
ERLCENRERERCLCON
ERLOEENEERERECCON
ERERC LN
OUENERRRE0O00EMm H

ERLCEN

i

n

n

u
SLUOENNER
B CEEEERERRERC

Par défaut

QK Annuler

Figure 5 : La boite de dialogue Couleur d’'onglet

Ouvrir des fichiers CSV

Les fichiers a Valeurs Séparées par des Virgules (Comma-Separated-Values : CSV) sont des
fichiers texte qui peuvent étre lus, affichés et modifiés dans une seule feuille de calcul. Chaque
ligne d’'un fichier CSV représente une ligne d’'une feuille de calcul. Les virgules, les points-virgules
ou d'autres caractéres sont utilisés pour séparer les cellules. Le texte peut étre saisi entre des
guillemets ; les nombres sont saisis sans guillemets.

> Conseil

La plupart des fichiers CSV proviennent de tables, requétes et rapports de bases de
données ou des calculs et diagrammes supplémentaires sont nécessaires. Sous
Microsoft Windows, les fichiers CSV ont souvent I'extension .xIs pour ressembler a
des fichiers Excel mais leur structure interne reste celle des fichiers CSV.

Pour ouvrir un fichier CSV dans Calc :

1) Choisissez Fichier > Ouvrir dans la barre de menu et recherchez le fichier CSV que vous
voulez ouvrir.

2) Sélectionnez le fichier et cliquez sur Ouvrir. Par défaut un fichier CSV a I'extension .csv
mais certains ont pour extension .txt.

3) Dans la boite de dialogue Import de texte (Figure 6), sélectionnez les diverses options dis-
ponibles pour importer un fichier CSV dans un classeur de Calc.

4) Cliquez sur OK pour ouvrir le fichier.

Les diverses options pour I'importation des fichiers CSV dans une feuille de calcul de Calc sont les
suivantes :

* Importer
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— Jeu de caractéres — définit le jeu de caractéres a utiliser pour importer le fichier.

— Langue — Détermine comment les chaines de nombres sont importées.
Si la langue est définie comme Par Défaut pour I'importation CVS, Calc utilisera la
langue définie globalement. Si elle est définie comme langue spécifique, celle-ci sera
utilisée pour importer les nombres.

— A partir de la ligne — précise la ligne ou vous désirez commencer I'importation. Les
lignes sont visibles dans la fenétre d’apercu au bas de la boite de dialogue.

Import de texte - [Auto220Compactes.csv] >

Importer

leu de caractéres :

Langue: Par défaut - Frangais (France) e |
A partir de la ligne: |1 =

Options de séparateur
l:::ll__argeurfixe @iéparé par

[] Tabulation Eirgule Eu:uint-virgule Dgspace [ Autre
DEusiDnnerIesséparateurs Séparateur detexte: |" |

Autres options

[ ] Champ entre guillemets comme texte [] Détecter les nombres spéciaux
Champs
Type de colonne: I:I
|Star1dard |Star1dard Standard Y
1 Marque Citroen
2 Modéle c4
3 Type 1,4 i 16v 9@ ch-BCV 1.6 HDi 92ch-5 CV
4 Finition confort confort
5 Prix de base 153750 20750
f Prix total 19230 21920
7 Prix camf (Février 2oi@) 415430 17270
g lramis 15066 17477 W
£ >
Aide QK Annuler

Figure 6 : Boite de dialogue Import de texte, avec le point-virgule et la tabulation
comme séparateurs de colonne et le guillemet comme séparateur de texte

+ Options de séparateur — précise si vos données utilisent des séparateurs ou des largeurs
fixes comme délimiteurs.

— Largeur fixe — sépare des données de largeur fixée (nombre égal de caractéres) en
colonnes. Cliquez sur la régle dans la fenétre d’apercu pour définir la largeur.

— Séparée par — Choisissez le séparateur utilisé dans vos données pour les délimiter.
Quand vous choisissez Autre, vous précisez le caractére utilisé pour séparer vos don-
nées en colonnes. Le séparateur personnalisé doit aussi étre contenu dans vos don-
nées.

— Fusionner les séparateurs — combine des délimiteurs consécutifs et supprime les
champs de données vides.
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— Séparateur de texte — sélectionnez un caractere pour délimiter les données textuelles.
* Autres options

— Champ entre guillemets comme texte — quand cette option est activée, les champs et
cellules dont les valeurs sont entierement entre guillemets (le premier et le dernier
caracteres de la valeur sont égaux au délimiteur de texte) sont importés comme textes.

— Détecter les nombres spéciaux — quand cette option est activée, Calc va automatique-

ment détecter tous les formats de nombres, y compris les formats spéciaux tels que les
dates, les heures et la notation scientifique. La langue sélectionnée influence aussi la
maniére dont ces nombres spéciaux sont reconnus puisque des langues et des régions
différentes peuvent avoir des conventions différentes pour de tels nombres.
Quand cette option est désactivée, Calc ne va détecter et convertir que les nombres
décimaux. Le reste, y compris les nombre formatés en notation scientifique, seront
importés sous forme de texte. Une chaine représentant un nombre décimal peut posseé-
der des chiffres de 0 a 9, des séparateurs de milliers et un séparateur décimal. Les
séparateurs des milliers et décimal peuvent changer selon la langue et la région sélec-
tionnées.

* Champs — montre I'aspect de vos données séparées en colonnes.

— Type de colonne — sélectionnez une colonne dans la fenétre d’apercu et le type de don-
nées a appliquer aux données importées.

— Standard — Calc détermine le type de données.

— Texte — les données importées sont traitées comme du texte.

— Date(JMA)/Date(MJA)/Date(AMJ) — les données importées sont traitées comme des
dates avec le format indiqué.

— Anglais US — les nombres formatés en anglais US sont recherchés et inclus indépen-
damment de la langue du systéme. Aucun format de nombre n’est appliqué. S'il n'y a
pas d’entrées en anglais US, le format Standard est appliqué.

— Masquer — les données de la colonne ne sont pas importées.

La méthode ci-dessus fonctionne également avec les fichiers TXT.

3

" Attention
La méthode d’ouverture des fichiers CSV est propre au module Calc. Si vous ouvrez
un fichier *.csv ou *.txt avec un autre module de LibreOffice (Writer par exemple), le
comportement sera différent.

Enregistrer les classeurs

Pour enregistrer un classeur, voyez le Chapitre 1, Introduction a LibreOffice pour plus de détails
sur la facon d’enregistrer manuellement ou automatiquement. Calc permet aussi d’enregistrer les
classeurs dans toute une gamme de formats et aussi de les exporter dans les formats de fichiers
PDF, HTML et XHTML ; voyez le Guide Calc, Chapitre 6, Imprimer, exporter et envoyer par cour-
rier électronique pour plus d’informations.

Les classeurs peuvent étre enregistrés de trois maniéres :

* Appuyez sur Ctrl+S.
* Choisissez Fichier > Enregistrer (ou Tout enregistrer ou Enregistrer sous).
* Cliquez sur le bouton Enregistrer de la barre d’outils Standard.

Si le classeur n'a pas encore été sauvegardé précédemment, chacune de ces actions ouvrira la
boite de dialogue Enregistrer sous. Vous pourrez alors spécifier le nom du classeur et I'emplace-
ment du stockage.
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. Remarque

Si le classeur a été enregistré précédemment, alors I'enregistrer en utilisant la com-
mande Enregistrer (ou Tout enregistrer) va écraser la version existante. Toutefois,
Vous pouvez enregistrer le classeur a un emplacement différent ou avec un nom diffé-
rent en sélectionnant Fichier > Enregistrer sous.

Enregistrer sous d’autres formats de classeurs

Si vous devez échanger des fichiers avec des utilisateurs qui ne peuvent pas recevoir des fichiers
dans le Format Open Document (ODF) (*.ods), que Calc utilise par défaut, vous pouvez enregis-
trer un classeur dans un autre format.

1) Important — Enregistrez tout d'abord votre classeur dans le format de fichier ODF utilisé
par LibreOffice, *.ods. Si vous ne le faites pas, toutes les modifications que vous aurez pu
effectuer depuis le moment de votre dernier enregistrement apparaitront uniguement dans
la version Microsoft Excel du document.

2) Puis choisissez Fichier > Enregistrer sous. Dans la barre de menu pour ouvrir la boite de
dialogue Enregistrer sous (Figure 7)

Enregistrer sous x|
Dyjwand\Documents - SEMVEUrS... @ ]
Signets Mom Type de contenu | Taille |Date de mo
(3 Mes document [ ipreOffice Dossier 14/06/20 A
7 Mes Textes Dossier 14/06/20
[ ShareX Dossier 13/06/20
[ Mes eBooks Dossier 10/06/20
[ College Dossier 08/06/20
(3 Arduine Dossier 06/06/20
(7 Fritzing Dossier 06/06/20
sl 3 My Digital Editions Dossier 24/05/20 w
Mom de fichier: 5Sans nom 1 ' Enregistrer
Type defichier: 28 Annuler
Classeur QDF (Lods)
[] Enregistrer avgModele de classeur ODF (.ots] Aide
Editer les para Flat XML ODF Spreadsheet (fods) —
B Classeur Unified Office Format ((uos)

Microsoft Excel 2003 XML (xrml)
Microsoft Excel 97-2003 (xls)
Maodéle Microsoft Excel 97-2003 (xlt)
Data Interchange Format (.dif)
dBASE (.dbf)

Document HTML (Calc) (html)
SYLE (slk)

Texte C5V (Losv)

Figure 7 : Enregistrer un classeur au format Microsoft Excel

3) Dans Nom de Fichier, vous pouvez saisir un nouveau nom pour votre classeur.
4) Dans le menu déroulant Type de fichier, sélectionnez le type de format que vous désirez
utiliser.
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5) Si Extension automatique du nom de fichier est cochée, I'extension correcte pour le for-
mat que vous avez sélectionné sera ajoutée au nom du fichier.

6) Cliquez sur Enregistrer.

7) Chaque fois que vous cliquez sur Enregistrer, la boite de dialogue Confirmer le format de
fichier (Figure 8) s’ouvre. Cliquez sur Utiliser le format XXX ... pour terminer I'enregistre-
ment dans le format que vous avez choisi ou cliquez sur Utiliser le format ODF pour enre-
gistrer le classeur dans le format .ods de Calc.

Confirmer le format de fichier ot

Ce document peut contenir des formatages ou du contenu qui ne peut pas étre
enregistré dans le format de fichier "Microsoft Excel 2007-2013 XML"
actuellement sélectionné.

Utilisez le format de fichier ODF par défaut afin d'étre sir que le docurment est correctement
enregistré.

Demander lors d'un enregistrernent dans un format autre que ODF ou le format par défaut

Utiliser le format Microsoft Excel 2007-2013 XML Utiliser le format ODF

Figure 8 : Message de confirmation lors de I'enregistrement dans un format autre qu’ODF

Si vous choisissez le format Texte CSV (*.csv) pour votre classeur, la boite de dialogue Export de
fichiers texte (Figure 9) s’ouvre. Vous pouvez y choisir le jeu de caracteres, le séparateur de
champ, le séparateur de texte, etc. a utiliser pour le fichier CSV.

Export de fichiers texte >

Options de champ

Jeu de caractéres:

Séparateur de champ : -

[

Separateur de texte : -

Enregistrer le contenu de la cellule comme affiché
] Enregistrer les formules de cellule au lieu des valeurs calculées
[] Mettre entre guillernets toutes les cellules de texte

] Largeur de colonne fixe

Aide QK Annuler

Figure 9 : Choix des options lors de I'export en Texte CSV

.
4’ Attention

A partir de ce moment, toutes les modifications que vous apporterez au classeur
auront lieu uniquement dans le document au nouveau format. VVous avez changé
le nom et le type de fichier de votre document. Si vous voulez revenir en arrieére pour
travailler avec la version *.ods de votre classeur, vous devez I'ouvrir a nouveau.

Une autre solution consiste a utiliser la commande Enregistre une copie, plutbt que
Enregistrer sous : dans ce cas, les nouvelles modifications sont toujours faites dans
le fichier au format original.
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> Conseil

Pour que Calc enregistre par défaut les documents dans un format autre que ODF,
sélectionnez Outils > Options > Chargement/Enregistrement, dans Format de
fichier par défaut et paramétrage ODF, sélectionnez Classeur dans Type de docu-
ment et votre format favori dans Enregistrer systématiquement sous.

Naviguer dans les classeurs

Calc propose de nombreuses fagons de naviguer a l'intérieur d’'un classeur, de cellule a cellule et
de feuille a feuille. Vous pouvez en général utiliser la méthode que vous préférez.

Aller vers une cellule particuliére

Quand une cellule est sélectionnée ou activée, ses bordures sont plus épaisses. Quand un groupe
de cellule est sélectionné, I'espace des cellules est coloré. La couleur de la bordure de la cellule
activée et celle du groupe sélectionné dépendent du systeme d’exploitation utilisé et de la fagon
dont vous avez configuré LibreOffice.

« Utiliser la souris - Placez le pointeur de la souris sur la cellule et cliquez avec le bouton
gauche de la souris. Pour activer autre cellule avec la souris, déplacez simplement le poin-
teur de la souris sur la cellule que vous voulez activer et faites un clic avec le bouton
gauche.

« Utiliser une référence de cellule — Sélectionnez ou effacez la référence de cellule qui se
trouve dans la Boite de nom de la Barre de Formule (Figure 1, page 10). Tapez la réfé-
rence de la cellule ol vous voulez aller et appuyez sur Entrée. Les références de cellules
peuvent étre saisies en majuscules ou en minuscules : a3 ou A3, par exemple, sont iden-
tiques.

» Utiliser le Navigateur — Cliquez sur le bouton Navigateur & de la barre d'outils Stan-

dard (ou appuyez sur F5) pour afficher le Navigateur, ou cliquez sur I'onglet du Navigateur
dans le volet latéral. Tapez la référence de cellule dans les deux champs du haut, intitulés
Colonne et Ligne, et appuyez sur Entrée. Dans la Figure 10, le Navigateur sélectionnera

la cellule Al.

Colonne A | EH

. FE R e
Ligne 1 |

= EH Feuilles 2| |
Feuilled
Feuille2
Feuilles
Feuille3
Feuille1
__Feuille6

 HiNoms de plage

& Plages de base de données

P Plages lices .
£\] L
Sans nom1 (actif) ~

Figuré 10:Le Navigateur de Calc
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Pour plus d’informations sur I'utilisation du Navigateur, le chapitre 1, Introduction a Calc, du
Guide Calc.

Utiliser les touches Tab et Entrée

— Appuyer sur Entrée ou Maj+Entrée active respectivement par défaut la cellule au-
dessous et au-dessus de la cellule actuellement active dans la méme colonne.

— Appuyer sur Tab ou Maj+Tab active respectivement la cellule a droite et a gauche de
la cellule actuellement active sur la méme ligne.

Utiliser les touches fléches — Appuyer sur les touches fleches du clavier déplace le focus
dans la direction des fléches.

Utiliser Début, Fin, Page précédente et Page suivante

Début déplace le focus au début d'une ligne.

Fin déplace le focus vers la colonne la plus a droite qui contient une donnée.

Page suivante (PgSuiv) déplace I'affichage d’'un écran complet vers le bas

— Page précédente (PgPrec) déplace I'affichage d’'un écran complet vers le haut.

Se déplacer de feuille en feuille

Chaque feuille dans un classeur est indépendante des autres, bien qu’elles puissent étre liées par
des références d'une feuille a l'autre. 1l y a trois facons de naviguer entre les différentes feuilles
d’'un classeur.

Avec le navigateur — Dans le navigateur (Figure 10, page 20), cliquez sur le symbole + a
cOté de Feuilles pour voir la liste des feuilles du classeur. Double-cliquez sur la feuille a

atteindre.
Avec le clavier — Appuyez sur Ctrl+Page suivante pour vous déplacer d’une feuille

vers la droite et appuyez sur Ctrl+Page précédente pour vous déplacer d'une feuille

vers la gauche.
Avec la souris — Cliquer sur un des onglets en bas du classeur permet de sélectionner la

feuille correspondante.

Si votre classeur contient beaucoup de feuilles, certains des onglets peuvent alors étre cachés
derriére la barre de défilement horizontal en bas de I'écran. Si c’est le cas :

Les quatre boutons a la gauche des onglets peuvent alors faire apparaitre les onglets
cachés. La Figure 11 montre comment le faire.

Premiére feuille
Feuille précédente
Feuille suivante

Derniére feuille

MNouvelle feuille ala fin  Onglets des feuilles

vy I T

M 4 p M | Feuillez | Feuilles | Feuille3 | Feullled | Feuille

Figure 11 : Fleches d’onglet des feuilles

Un clic droit sur un des boutons ouvre un menu contextuel ol vous pouvez sélectionner
une feuille (voir Figure 12).

Si les noms des onglets dépassent la largeur de I'écran, il est possible d'afficher les noms
des onglets cachés en faisant tourner la molette de la souris lorsque le curseur est au des-
sus d’'un onglet.
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e Remarques

26
7

Eeuilles
| | Feuilled
- Feuilled
B Feuilleg

Feuilleg

" Feuille3d
= Feuille?
B Feuilled
Feuillel
Feuille1d

: uilled | Feuilled |
Feuille & sur 10 Par défaut
Figure 12 : Un clic droit sur un des cinq boutons

Notez que les feuilles ne sont pas forcément numérotées dans I'ordre. La numérota-
tion des feuilles est arbitraire. La barre d'état de la Figure 12 indique que Feuille6 est
en quatrieme position parmi les sept feuilles du classeur. Il est recommandé de
renommer les feuilles pour les reconnaitre plus facilement.

Navigation au clavier

Vous pouvez parcourir un classeur avec le clavier, en appuyant sur une touche ou une combinai-
son de touches. Dans ce cas, appuyez sur plusieurs touches a la fois. Le Tableau 1 donne la liste
des touches et combinaisons de touches que vous pouvez utiliser pour parcourir un classeur dans

Calc.

Tableau 1 : Se déplacer de cellule a cellule en utilisant le clavier

Combinaison de
touches

—

«—

1
!
Ctrl+-

Ctril+-—

Mouvement

Une cellule sur la droite
Une cellule sur la gauche
Une cellule vers le haut
Une cellule vers le bas

Vers la premiére colonne sur la droite contenant une donnée sur cette ligne
si la cellule active est vide.

Vers la derniere cellule sur la droite dans la méme plage de cellules
occupées sur cette ligne si la cellule active contient des données.

Vers la derniére colonne a droite dans la feuille de calcul s’il n’y a plus de
cellules a droite contenant des données.

Vers la derniere colonne sur la gauche contenant une donnée sur cette
ligne si la cellule active est vide.

Vers la premiére cellule sur la gauche dans la méme plage de cellules
occupées sur cette ligne si la cellule active contient des données.

Vers la premiére colonne dans la feuille de calcul s'il n'y a plus de cellules a
gauche contenant des données.
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Combinaison de
touches

Ctril+1

Ctrl+\

Ctrl+Début
Ctrl+Fin

Alt+PgSuiv
Alt+PgPrec
Ctrl+PgSuiv
Ctrl+PgPrec
Tab

Maj+Tab
Entrée
Maj+Entreée

> Conseil

Mouvement

Vers la premiére cellule vers le haut contenant une donnée dans cette
colonne si la cellule active est vide.

Vers la premiére ligne de la méme plage de cellules occupées si la cellule
active contient des données.

Vers la premiére ligne de la feuille de calcul s'il n'y a plus de cellule au-
dessus contenant des données.

Vers la premiére cellule vers le bas contenant une donnée dans cette
colonne si la cellule active est vide.

Vers la derniere ligne de la méme plage de cellules occupées si la cellule
active contient des données.

Vers la derniéere ligne de la feuille de calcul s'il n'y a plus de cellule au-
dessus contenant des données.

Vers la cellule A1 de la méme feuille.

Vers le coin inférieur droit de la zone rectangulaire qui contient des
données dans la méme feuille

Un écran sur la droite (si possible)

Un écran sur la gauche (si possible)

Vers la méme cellule dans la feuille sur la droite (dans les onglets)
Vers la méme cellule dans la feuille sur la gauche (dans les onglets)
Vers la prochaine cellule sur la droite

Vers la prochaine cellule sur la gauche

Une cellule vers le bas (sauf changement par I'utilisateur)

Une cellule vers le haut (sauf changement par I'utilisateur)

Utilisez A1t + Fléche droite ou A1t + Fléche gauche pour augmenter ou
diminuer la largeur d’'une cellule.

Personnaliser la touche Entrée

Vous pouvez personnaliser la direction dans laquelle la touche Entrée déplace I'activation de la
cellule en allant dans Outils > Options > LibreOffice Calc > Général. Sélectionnez la direction
du mouvement dans la liste déroulante. Selon le fichier utilisé ou le type de données saisies, une
direction différente peut étre utile. La touche Entrée peut aussi étre utilisée pour passer en et
hors mode d’édition. Utilisez les deux premiéres options sous Paramétres de saisie (Figure 13)

pour changer le paramétrage de la touche Entrée.
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Paramétres de saisie

Appuyer sur Entrée pour déplacer la sélection

(] Appuyer sur Entrée pour basculer dans le mode Edition

(] Etendre le formatage

U] Etendre les références lors de I'insertion de colonnes/lignes

L] Mettre a jour les références lors du tri de plages de cellules

Figure 13 : Personnaliser la touche Entrée

Sélectionner des éléments dans une feuille ou un classeur

Sélectionner des cellules

Cellule individuelle

Faites un clic gauche dans la cellule. Vous pouvez vérifier votre sélection en regardant dans la
Boite de nom de la barre de formule (Figure 1 page 10).

Plage de cellules contigués
Vous pouvez sélectionner une plage de cellules en utilisant le clavier ou la souris.

Pour sélectionner une plage de cellules en faisant glisser la souris :

1) Cliquez dans une cellule.

2) Appuyez et gardez appuyé le bouton gauche de la souris.

3) Déplacez la souris sur I'écran.

4) Une fois que le bloc de cellules souhaité est en surbrillance, relachez le bouton gauche de
la souris.

Pour sélectionner une plage de cellules sans faire glisser la souris :

1) Cliguez dans la cellule qui sera un des coins de la plage de cellules.
2) Déplacez la souris dans le coin opposé de la plage de cellules.
3) Gardez appuyée la touche Maj et cliquez.

> Conseil

Vous pouvez aussi sélectionner une plage de cellules contigués en commencant par
cliquer sur le champ Mode de sélection de la barre d’Etat (Figure 3 page 12) et en
choisissant Sélection étendue avant de cliquer sur les coins opposés de la plage de
cellules. Assurez-vous de revenir a Sélection standard ou vous pourriez vous retrou-
vez en train d’étendre involontairement une sélection de cellule.

Pour sélectionner une plage de cellules sans utiliser la souris :

1) Sélectionnez la cellule qui sera un des coins de la plage de cellules.
2) En gardant appuyée la touche Maj, utilisez les fleches du curseur pour sélectionner le
reste de la plage.
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> Conseil

Vous pouvez également sélectionner directement une plage de cellules en utilisant la
Boite de nom de la barre de formule (Figure 1 page 10). Cliquez dans la Boite de
nom comme décrit dans “Utiliser une référence de cellule” page 20. Pour sélection-
ner une plage de cellules, saisissez la référence de cellule du coin supérieur gauche,
suivi de deux points (:), et ensuite de la référence de cellule du coin inférieur droit. Par
exemple, pour sélectionner la plage qui va de A3 a C6, vous saisiriez A3:C6.

Plage de cellules non contigués

1) Sélectionnez la cellule ou la plage de cellules en utilisant une des méthodes ci-dessus.

2) Déplacez le pointeur de la souris vers le début de la prochaine plage ou cellule individuelle.

3) Maintenez appuyée la touche Ctrl et cliquez ou cliquez et faites glisser pour sélectionner
une autre plage de cellules a ajouter a la premiére plage.

4) Répétez autant que nécessaire.

La combinaison Ctrl+clic permet aussi de désélectionner certaines cellules ou plage de cellules
dans une sélection existante.

Sélectionner des colonnes et des lignes

Colonne ou ligne individuelle
Pour sélectionner une colonne individuelle, cliquez sur la lettre identifiant la colonne (voir Figure 1
page 10) ou utilisez le raccourci-clavier Ctrl1+Espace.

Pour sélectionner une ligne individuelle, cliquez sur le numéro identifiant la ligne ou utilisez le rac-
courci-clavier Maj+Espace.

Colonnes ou lignes multiples
Pour sélectionner des colonnes ou lignes multiples qui sont contigués :
1) Cliquez sur la premiere colonne ou ligne du groupe.

2) Gardez appuyée la touche Maj.
3) Cliquez sur la derniére colonne ou ligne du groupe.

Pour sélectionner des colonnes ou lignes multiples qui ne sont pas contigués :

1) Cliguez sur la premiére colonne ou ligne du groupe.
2) Gardez appuyée la touche Ctrl.
3) Cliquez sur toutes les colonnes ou lignes suivantes en gardant appuyée la touche Ctrl.

Feuille entiére
Pour sélectionner la feuille entiere, cliquez dans la petite boite entre I'en-téte de colonne A et I'en-
téte de ligne 1 (Figure 14). Vous pouvez également appuyer sur Ctrl1+A ou Ctrl+Maj+Espace

pour sélectionner la feuille entiére ou aller dans le menu Edition et sélectionner Tout sélection-
ner.

Al v

) Tout sélectionner

Figure 14 : Boite Tout sélectionner
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Sélectionner des feuilles

Vous pouvez sélectionner une ou plusieurs feuilles. Il peut étre intéressant de sélectionner plu-
sieurs feuilles en méme temps si vous voulez effectuer des modifications dans plusieurs feuilles en
une seule fois.

Feuille individuelle

Cliquez sur I'onglet de la feuille que vous voulez sélectionner. L'onglet de la feuille active devient
blanc dans le paramétrage par défaut de Calc (voir Figure 11 page 21).

Plusieurs feuilles contigués
Pour sélectionner plusieurs feuilles contigués :
1) Cliquez sur I'onglet de la premiere feuille désirée.

2) Déplacez le pointeur de la souris sur I'onglet de la derniére feuille désirée.
3) Gardez appuyée la touche Maj et cliquez sur I'onglet.

Tous les onglets entre ces deux feuilles deviennent blancs (avec le paramétrage par défaut). Toute
action que vous ferez affectera désormais toutes les feuilles en surbrillance.

Plusieurs feuilles non contigués
Pour sélectionner plusieurs feuilles non contigués :
1) Cliquez sur I'onglet de la premiéere feuille désirée.
2) Déplacez le pointeur de la souris sur I'onglet de la deuxiéme feuille désirée.
3) Gardez appuyée la touche Ctrl et cliquez sur I'onglet.
4) Répétez autant que nécessaire.

Les onglets sélectionnés deviennent blancs (avec le paramétrage par défaut). Toute action que
vous ferez affectera désormais toutes les feuilles en surbrillance.

Toutes les feuilles

Faites un clic droit sur I'un des onglets et choisissez Sélectionner toutes les feuilles dans le
menu contextuel.

Pour désélectionner

Pour revenir au fonctionnement par défaut avec une seule feuille sélectionnée, il suffit de cliquer
sur l'onglet d’'une feuille non sélectionnée. Si toutes les feuilles sont sélectionnées, faites un
Ctrl+clic sur un des onglets.

6 Remarque

Si une couleur d’onglet a été définie pour une feuille, lorsque cette feuille est sélection-
née, la couleur n'apparait qu’en bas de l'onglet et le reste de la zone devient blanc.

“ " Attention

Une fois les modifications effectuées sur les différentes feuilles, pensez a revenir
une seule feuille sélectionnée, sinon vos modifications continueront a s'appliquer
toutes les feuilles. Pour cela, cliquez sur I'onglet d’une feuille non sélectionnée.

e\

QD Q-
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Actions sur les colonnes et les lighes

Insérer des colonnes et des lignhes

“ Remarque

Les cellules des nouvelles colonnes ou lignes sont formatées comme les cellules cor-
respondantes de la colonne ou de la ligne avant les (ou a gauche des) nouvelles
colonnes ou lignes insérées.

Colonne ou ligne individuelle
Utiliser le menu Feuille :

1)

2)

Sélectionnez la cellule, colonne ou ligne ou vous voulez insérer la nouvelle colonne ou
ligne.

Sélectionnez Feuille dans la barre de menu et sélectionnez soit Insérer des colonnes >
Colonnes de gauche ou Colonnes de droite soit Insérer des lignes > Lignhes au-des-
sus ou Lignhes en dessous.

Utiliser la souris :

1)
2)
3)

Sélectionnez la colonne ou la ligne ou vous voulez insérer la nouvelle colonne ou ligne.
Faites un clic droit sur I'en-téte de colonne ou de ligne.

Choisissez Insérer des colonnes a gauche, Insérer des colonnes a droite, Insérer des
lignes au-dessus ou Insérer des lignes au-dessous dans le menu contextuel.

Colonnes ou lignes multiples
Les colonnes ou lignes multiples peuvent étre insérées en une fois plutdt qu’une par une.

1)

2)

Mettez en surbrillance le nombre voulu de colonnes et de lignes en gardant appuyé le bou-
ton gauche de la souris sur la premiére et ensuite en le faisant glisser sur le nombre voulu
d’identifiants.

Procédez comme pour insérer une seule colonne ou ligne ci-dessus.

Supprimer des colonnes et des lighes

Les colonnes et les lignes peuvent étre supprimées individuellement ou par groupes.

Colonne ou ligne individuelle
Une colonne ou ligne individuelle peut étre supprimée en utilisant la souris :

1)
2)

3)

Sélectionnez une cellule dans la colonne ou la ligne a supprimer.

Choisissez Feuille > Supprimer des cellules depuis la barre de menu ou faites un clic
droit et choisissez Supprimer dans le menu contextuel.

Cochez 'option dont vous avez besoin dans la boite de dialogue Supprimer des cellules
(Figure 15).

Supprimer des cellules m

Sélection

QK

® Déplacer les cellules vers e haut!

(O Déplacer les cellules vers la gauche Annuler

(O Supprimer des lignes entiéres

() Supprimer des colonnes entiéres Aide

Figure 15 : La boite de dialogue Supprimer des cellules
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Vous pouvez aussi

1) Cliguer sur I'en-téte de la colonne ou de la ligne pour la sélectionner.

2) Sélectionner Feuille dans la barre de menu et choisir Supprimer des colonnes ou Sup-
primer des lignes ou faire un clic droit sur I'en-téte et choisir Supprimer des colonnes ou
Supprimer des lignes dans le menu contextuel.

Colonnes ou lignes multiples
Les colonnes ou lignes multiples peuvent étre supprimées en une fois plutdt qu’'une par une.
1) Mettez en surbrillance le nombre voulu de colonnes ou de lignes (voir « Colonnes ou

lignes multiples » page 25 pour plus d’information).
2) Procédez comme pour supprimer une seule colonne ou ligne comme ci-dessus.

> Conseil

Au lieu de supprimer une ligne ou une colonne, vous pouvez souhaiter supprimer les
contenus des cellules, mais garder la ligne ou la colonne vide. Voir le chapitre 2 du
guide Calc (Saisir, modifier et formater les données) pour instructions.

Actions sur les feuilles

Insérer de nouvelles feuilles

Il'y a plusieurs facons d’'insérer une nouvelle feuille. La méthode la plus rapide est de cliquer sur le
bouton Ajouter une feuille * (voir Figure 11). Elle insére une nouvelle feuille aprés la derniére,

sans ouvrir la boite de dialogue Insérer une feuille. Les méthodes suivantes ouvrent la boite de
dialogue Insérer une feuille (Figure 16) ol vous pouvez insérer plus d'une feuille, renommer la
feuille, insérer la feuille ailleurs dans la séquence ou choisir une feuille dans un fichier.

Insérer une feuille n

Position
; : e OK
(@ idyant |a feuille active!
i Aprés la feuille active A
Feuille _
(®) Mouvelle feuille Bide
Mombre de feuilles: |1 S
Mom : Feuilled

() A partir d'un fichier

Parcourir...

Lier

Figure 16 : La boite de dialogue Insérer une feuille
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Sélectionnez les feuilles prés desquelles la nouvelle feuille va étre insérée. Puis utilisez I'une des
options suivantes.

* Choisissez Feuille > Insérer une feuille depuis la barre de menu.

» Faites un clic droit sur I'onglet ou dans I'espace vide apres les onglets et choisissez Insérer
une feuille dans le menu contextuel.
Cliquez sur un espace vide a la fin de la ligne des onglets.

> Conseil

Vous pouvez fixer le nombre de feuilles des nouveaux documents en sélectionnant
Outils > Options > LibreOffice Calc > Par défaut. Par défaut, une seule feuille de
calcul est créée lors de la création d’'un nouveau document.

Déplacer et copier des feuilles

Vous pouvez déplacer ou copier des feuilles dans le méme classeur par glisser/déposer ou en utili-
sant la boite de dialogue Déplacer/copier la feuille. Pour déplacer ou copier une feuille dans un
autre classeur, vous devez utiliser cette boite de dialogue.

Par glisser et déposer
Pour déplacer une feuille & une position différente dans le méme classeur, cliquez et maintenez le

bouton appuyé sur I'onglet de la feuille et tirez-le a sa nouvelle position avant de relacher le bou-
ton.

Pour copier une feuille dans le méme classeur, maintenez la touche Ctrl appuyée (la touche
Option sur Mac) puis cliquez sur I'onglet de la feuille et tirez-le a sa nouvelle position avant de
relacher le bouton de la souris. Le pointeur de la souris peut changer et comporter un signe plus
selon la configuration de votre systeme d’exploitation.

37

an
£

PN
+ [ Feuillel |1 Feuilled ¥ Feullled |

Feuille 1sur 3

Figure 17 : Faire glisser une feuille pour la déplacer

En utilisant une boite de dialogue

Utilisez la bofte de dialogue Déplacer/copier la feuille (Figure 18) pour spécifier exactement si vous
voulez déplacer ou copier la feuille dans le méme classeur ou dans un autre, indiquer sa position
dans le classeur et son nom.

1) Dans le document en cours, faites un clic droit sur I'onglet de la feuille que vous désirez
déplacer ou copier puis sélectionnez Déplacer/copier la feuille dans le menu contextuel
ou sélectionnez Feuille > Déplacer/copier la feuille dans la barre de menu.

2) Dans la section Action, cochez Déplacer pour déplacer la feuille ou Copier pour la copier.

3) Choisissez le classeur ou vous désirez placer la feuille dans la liste déroulante Vers le
document. Cela peut étre le méme classeur, un autre classeur déja ouvert ou un nouveau
classeur.

4) Définissez dans Insérer avant la position ou vous voulez placer la feuille.

5) Tapez un nom dans la boite de texte Nouveau nom si vous voulez renommer la feuille en
la déplacant ou en la copiant. Si vous ne précisez pas de nom, Calc en crée un par défaut
(Feuille 2, Feuille 3, etc.).

6) Cliquez sur OK pour confirmer I'opération et fermer la boite de dialogue.
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Déplacer/copier la feuille “

(® Déplacer; () Copier

Emplacement

Vers le document

|Sa ns nom1 [document actif) e |

Insérer avant

Feuillel

Feuille2
Feuille3
- placer en derniére position -

MNouveau nom
Feuille2

Aide Ok Annuler

Figure 18 : La boite de dialogue Déplacer/copier la feuille

E—
" Attention

Si vous choisissez comme document de destination un autre classeur ouvert ou - hou-
veau document -, cela peut créer des conflits pour les formules liées a d'autres
feuilles du document d'origine. Si vous déplacez involontairement une feuille, vous
pouvez y remeédier en déplagant ou copiant la feuille & son emplacement d’origine.

Supprimer des feuilles

Feuille individuelle

Faites un clic droit sur I'onglet que vous voulez supprimer et choisissez Supprimer la feuille dans
le menu contextuel, ou choisissez Feuille > Supprimer des feuilles dans la barre de menu. Dans
tous les cas, un avertissement vous demandera si vous voulez supprimer la feuille définitivement.
Cliquez sur Oui.

Feuilles multiples

Pour supprimer des feuilles multiples, sélectionnez-les comme décrit auparavant (page 26), puis
faites un clic droit sur I'un des onglets et choisissez Supprimer la feuille dans le menu contextuel,
ou choisissez Feuille > Supprimer des feuilles dans la barre de menu. Cliquez sur Oui pour
confirmer la suppression.

Renommer des feuilles

Le nom par défaut d’'une nouvelle feuille est aaaX, ou aaa est le préfixe défini dans Outils >
Options > LibreOffice Calc > Par défaut (Feuille par défaut) et X est un numéro. Si cela convient
pour un petit classeur avec seulement quelques feuilles, cela devient moins lisible lorsqu’il y en a
beaucoup.

30 | Débuter avec Calc



Pour donner a une feuille un nom plus significatif, vous pouvez :

» saisir le nom dans la Zone de nom (Figure 16 page 28) quand vous créez la feuille avec la
boite de dialogue Insérer une feuille ;

» faire un clic droit sur I'onglet et choisir Renommer la feuille dans le menu contextuel ; rem-
placer le nom existant par un nouveau.

» faire Alt+Clic surl'onglet pour y modifier directement le nom ;

» faire un double clic sur I'onglet pour ouvrir la boite de dialogue Renommer la feuille.

“ Remarque

Les noms de feuilles doivent étre unique dans le classeur et ne pas comporter les
caractéeres []*? :/\
Tenter de donner un nom incorrect a une feuille produit un message d’erreur.

Affichage de Calc

Modifier I'affichage du document

Utilisez la fonction zoom pour afficher plus ou moins de cellules dans la fenétre pendant que vous
travaillez sur un classeur. Pour plus de renseignement sur le zoom, voyez le Chapitre 1, Présenta-
tion de LibreOffice dans ce guide.

Fixer les lignes et les colonnes

Le fait de fixer verrouille un certain nombre de lignes en haut d'un classeur et un certain nombre
de colonnes a sa gauche ou les deux a la fois. Quand vous vous déplacez ensuite dans une
feuille, les cellules des lignes et colonnes figées restent toujours visibles.

La Figure 19 montre quelques lignes et colonnes fixées. Le trait horizontal plus épais entre les
lignes 4 et 14 ainsi que le trait vertical entre les colonnes B et G indiguent que les lignes 1 a 4 et
les colonnes A et B sont figées. Les lignes de 5 a 13 et les colonnes de C a F ont été décalées
hors de l'affichage.

A B G H I J K
1 |Classe 6éme 1 01/04 09/04 12/04 03/05| 05/05
2 |Année 2010-2011 IE IE Div DS6 DM6EBis |Exos
3 [Trimestre
4 Noms Prénoms 2,0 2,0 3,0 1,0 1,0
14 IMARCELINE Oceéane 18,5 11,5 10,0 12,5 18,0
15 |MICHELIN Gaetan 10,5 10,5 13,5 20,00 17,0

Figure 19 : Lignes et colonnes fixées

Comment fixer des lignes ou des colonnes
1) Vous pouvez cliquer sur

— Il'en-téte de la ligne sous celles que vous voulez fixer,
— I'en-téte de la colonne a droite de celles que vous voulez fixer.

2) Sélectionnez Affichage > Fixer des cellules > Fixer lignes et colonnes dans la barre de

menu ou cliquez sur l'icone Fixer lignes et colonnes El dans la barre d'outils Standard.
Une ligne plus épaisse apparait entre les lignes ou les colonnes fixées et libres.

\Vous pouvez aussi :
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1) Cliquer sur la cellule immédiatement sous les lignes et immédiatement a droite des
colonnes que vous voulez fixer.
2) Sélectionner Affichage > Fixer des cellules > Fixer lignes et colonnes dans la barre de

menu ou cliquer sur I'icone Fixer lignes et colonnes =] dans la barre d’'outils Standard.
Une ligne plus épaisse apparait entre les lignes et les colonnes fixées et libres.

Si vous souhaitez fixer uniquement la premiére ligne ou la premiére colonne, il vous suffit de sélec-
tionner Affichage > Fixer des cellules > Fixer la premiére ligne ou Fixer la premiére colonne,
sans qu’aucune sélection ou positionnement particulier ne soit nécessaire.

Comment libérer les lignes et les colonnes figées
Pour libérer les lignes ou les colonnes, sélectionnez Affichage > Fixer des cellules > Fixer

lignes et colonnes dans la barre de menu ou cliquez sur l'icbne Fixer lignes et colonnes El

dans la barre d'outils Standard. Les traits plus épais qui marquent les lignes et colonnes fixées dis-
paraitront et les lignes et colonnes libres qui étaient masquées réapparaitront.

Scinder I’écran

Une autre facon de changer l'affichage est de scinder la fenétre. L'écran peut étre scindé horizon-
talement, verticalement, ou les deux. Vous pouvez par conséquent avoir jusqu’a quatre portions de
la feuille & I'affichage en méme temps comme sur la Figure 20. A la différence de la commande
Fixer lignes colonnes, scinder I'écran permet de conserver un ascenseur dans chaque morceau de
la fenétre.

Pourquoi scinder la fenétre ? Un exemple serait un grand classeur dans lequel une des cellules
contient un nombre qui est utilisé par trois formules dans d’autres cellules. En scindant I'écran,
vous pouvez positionner la cellule contenant le nombre dans une section et chacune des cellules
avec formule dans les autres sections. Vous pouvez alors changer le nombre dans la cellule et voir
comment cela affecte les résultats de chacune des formules.

A B G H | ] K ~

1 [Classe 6eme 1 01/04] 00/04] 12/04| 03/05| 05/05
2 |Année 2010-2011 [IE  |IEDiv |DS6 DM6Bis |Exos
3 [Trimestre

4 Noms Prénoms 2,0 2,0 3,0 1,0 1,0/

14 |MARCELINE Océane 18,5 11,5 10,00 12,5 18,0/*
15 |MICHELIN Gaetan 10,5 10,5 13,5 200 17.0v
£ b K4 >

-|-| Liste | 1er trim | 2eme trim | deme trim Socle Oublis

Figure 20 : Exemple d’écran scindé

Comment scinder I’écran horizontalement ou verticalement
1) Vous pouvez cliquer sur

— I'en-téte de la ligne sous celles ou vous voulez scinder I'écran horizontalement,
— I'en-téte de la colonne a droite de celles ou vous voulez scinder I'écran verticalement.

2) Sélectionnez Affichage > Scinder la fenétre dans la barre de menu. Une ligne plus
épaisse apparait entre les lignes et les colonnes qui délimitent le partage (voir Figure 20).

Vous pouvez aussi (voir Figure 21)

» Tirer la nouvelle bordure de fenétre horizontale sous la ligne ou vous voulez placer le par-
tage horizontal.
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» Tirer la nouvelle bordure de fenétre verticale a droite de la colonne ou vous voulez placer le
partage vertical.

w
Tirez ici pour partager la fenétre horizontalement gy,
F | G ke

L

Tirez ici pour partager la fenétre verticalement \

>

Figure 21 : Partage interactif de la fenétre

Comment scinder I’écran horizontalement et verticalement

1) la cellule immédiatement sous les lignes et immédiatement a droite des colonnes ou vous
voulez scinder I'écran.

2) Sélectionnez Affichage > Scinder la fenétre dans la barre de menu. Une ligne plus
épaisse apparait entre les lignes et les colonnes qui délimitent le partage (voir Figure 20).

Comment supprimer le partage de I’écran
Pour annuler un partage de I'écran,
* replacez les bordures de fenétres scindées a leur position aux extrémités des barres de
défilement (Figure 21)

+ sélectionnez Affichage > Scinder la fenétre dans la barre de menu pour décocher l'op-
tion.

Saisir des données en utilisant le clavier

La plupart des saisies de données dans Calc peuvent étre faites en utilisant le clavier.

Saisir des nombres

Cliquez dans la cellule et tapez le nombre en utilisant les touches numériques soit de la partie prin-
cipale du clavier, soit du pavé numérique. Par défaut, les nombres sont alignés a droite.

Nombres négatifs
Pour entrer un nombre négatif, tapez le signe moins (-) devant celui-ci ou placez-le entre paren-
théses, par exemple (1234).

Le signe plus (+) n'est pas nécessaire pour les nombres positifs.

Zéros non significatifs

Pour conserver un nombre minimum de chiffres dans une cellule quand on saisit des nombres
dans le but de conserver le format numérique, par exemple 1234 et 0012, des zéros non significa-
tifs doivent étre ajoutés a l'aide d’'une des méthodes suivantes :

Méthode 1

1) La cellule étant sélectionnée, ouvrez la boite de dialogue Formatage des cellules (Figure
22) par I'une des méthodes suivantes :

— faites un clic droit sur la cellule et sélectionnez Formater des cellules dans le menu
contextuel,

— sélectionnez Format > Cellules dans la barre de menu,

— utilisez le raccourci Ctrl+1 au clavier.
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Formatage des cellules “
Mombres Police Effets de caractére Alignement Bordures Arriére-plan Protection de cellule
Catégorie Format Langue
_ |F‘ar défaut - Frangais (France) ~
Pourcentage -1234
Monnaie -1234,12
Date -1234
Heure -1234.12
Scientifique 123412
Fraction
Waleur logigue
Texte 1234, 567389
]
Options
Mombre de décimales : [ Mombres négatifs en rouge
ZLéros non significatifs: |1 = Séparateur de milliers
Description de format
Standard -4

Figure 22: La boite de dialogue Formatage des cellules — la page Nombres

2) Vérifiez que lI'onglet Nombres est sélectionné puis choisissez Nombre dans la liste Caté-
gorie.

3) Dans Options > Zéros non significatifs, saisissez le nombre minimum de caracteres
nécessaires. Par exemple, pour quatre caracteres, tapez 4. Tout nombre ayant moins de
guatre caractéres sera précédé de zéros non significatifs, par exemple 12 deviendra 0012.

4) Cliquez sur OK. Le nombre saisit conserve son format numérique et toute formule utilisée
dans le classeur traitera I'entrée comme un nombre dans les fonctions des formules.

Méthode 2

1) Sélectionnez la cellule.

2) Ouvrez le Volet latéral (Affichage > Volet latéral), activez la page Propriétés et cliquez
sur 'icone (+) d’ouverture du panneau Format numérique pour ouvrir celui-ci.

3) Choisissez Nombre dans la liste déroulante Catégorie.

4) Tapez 4 dans la boite Zéros non significatifs. Le format est immédiatement appliqué.

El Format numérigue =

Mombre de décimales | Zéros non significatifs :

2 = |4 -

[ Nombres négatifs en rouge
[] Séparateur de milliers

Figure 23: Définir le nombre de zéros non significatifs

Si un nombre est saisi avec des zéros non significatifs, par exemple 01481, sans que le paramé-

trage des zéros non significatifs ait été fait, par défaut Calc va automatiquement les supprimer.
Pour les préserver :

1) Tapez une apostrophe () avant le nombre, par exemple ‘01481.
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2) Activez une autre cellule. L'apostrophe est automatiquement supprimée, les zéros non

significatifs sont conservés et le nombre est converti en texte aligné a gauche.

Nombres sous forme de texte
Les nombres peuvent aussi étre saisis sous forme de texte grace a I'une des méthodes suivantes :

Méthode 1

1)

La cellule étant sélectionnée, ouvrez la boite de dialogue Formatage des cellules (Figure
22) par I'une des méthodes suivantes :

— faites un clic droit sur la cellule et sélectionnez Formater les cellules dans le menu
contextuel,

— sélectionnez Format > Cellules dans la barre de menu,

— utilisez le raccourci Ctr/+1 au clavier.

2) Vérifiez que I'onglet Nombres est sélectionné puis choisissez Texte dans la liste Catégorie.
3) Cliquez sur OK. Le nombre saisi est converti en texte et aligné par défaut a gauche.
Méthode 2
1) Sélectionnez la cellule.
2) Ouvrez le Volet latéral (Affichage > Volet latéral), activez la page Propriétés et cliquez
sur I'icdne (+) d’ouverture du panneau Format numérique pour ouvrir celui-ci.
3) Choisissez Texte dans la liste déroulante Catégorie. Le formatage est immédiatement
appliqué a la cellule.
4) Cliquez sur la cellule. Saisissez le nombre et activez une autre cellule pour que la donnée
soit mise en forme.
“ Remarque

Par défaut, tout nombre mis en forme comme texte dans un classeur sera traité

comme un zéro par tous les formules utilisées. Les fonctions ignorent les entrées tex-
tuelles dans les formules.

Saisir des textes

Cliquez dans la cellule et tapez le texte. Les textes sont alignés a gauche par défaut.

Pour saisir un texte de plusieurs lignes dans une cellule, vous pouvez insérer des retours a la ligne
en tapant Ctrl+Entrée.

Vous pouvez agrandir la zone de saisie en cliquant sur l'icobne Etendre la barre Formule ~ . La

zone de saisie devient alors multi-lignes (Figure 24). Cliquez a nouveau sur I'icbne « pour revenir

a la zone de saisie initiale.

1% T =

2

2
Figure 24 : Zone de saisie multi-ligne
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Saisir des dates et des heures

Sélectionnez la cellule et tapez la date ou I'heure.

Vous pouvez séparer les éléments de la date avec un slash (/) ou un tiret () ou utiliser un texte
comme 10 octobre 13. Calc reconnait plusieurs formats de date ; le format utilisé par Calc s’appli-
quera automatiquement.

Vous pouvez séparer les éléments de I'heure avec des deux-points comme 10:43:45. Le format
horaire utilisé par Calc s’appliquera automatiquement.

Pour modifier le format de date ou d’heure utilisé par Calc, appliguez une des méthodes suivantes.
Méthode 1

1)

La cellule étant sélectionnée, ouvrez la boite de dialogue Formatage des cellules (Figure
22) par I'une des méthodes suivantes :

— faites un clic droit sur la cellule et sélectionnez Formater les cellules dans le menu
contextuel,

— sélectionnez Format > Cellules dans la barre de menu,

— utilisez le raccourci Ctrl+1 au clavier.

2) Verifiez que I'onglet Nombres est sélectionné puis choisissez Date ou Heure dans la liste
Catégorie.

3) Choisissez le format que vous désirez utiliser dans la liste Format.

4) Cliquez sur OK.

Méthode 2

1) Sélectionnez la cellule.

2) Ouvrez le Volet latéral (Affichage > Volet latéral), activez la page Propriétés et cliquez
sur I'icéne (+) d’ouverture du panneau Format numérique pour ouvrir celui-ci.

3) Choisissez Date ou Heure dans la liste déroulante Catégorie.

4) Cliquez sur le bouton Plus d’options dans la barre de titre du panneau pour ouvrir la boite
de dialogue Formatage des cellules (Figure 22).

5) Choisissez le format que vous désirez utiliser dans la liste Format.

6) Cliquez sur OK.

= Format numérique Plus d'options =]

Date v| B~ % 00

Nombre de décimales Zéros non significatifs :

" .

. = L -

Figure 25 : Format Date

Les formats de saisie des dates reconnus par Calc peuvent étre définis dans I'option Motifs d’ac-
ceptation de date dans Outils > Options > Paramétres linguistiques > Langues, avec les nota-
tions suivantes : D pour le jour, M pour le mois et Y pour I'année.
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> Conseil

Les raccourcis clavier Ctrl+; et Maj+Ctrl+,; permettent d’entrer la date et I'heure
courante dans la cellule, respectivement formatées en date et en heure. L'entrée est
effectuée sous forme de valeur. Comme ce ne sont pas des fonctions ou des champs,
les données ne sont pas actualisées par la suite.

Options d’autocorrection

Calc applique automatiquement plusieurs changements durant la saisie de données, a moins que
vous n'ayez désactivé cette fonction. Vous pouvez également annuler immédiatement chaque
changement automatique avec Ctrl+Z ou en revenant manuellement a la modification pour rem-
placer I'autocorrection par ce que vous désirez voir vraiment.

Pour modifier les options d’autocorrections, sélectionnez Outils > Options d’autocorrection dans
la barre de menu pour ouvrir la boite de dialogue AutoCorrection (Figure 26).

AutoCorrection “
Remplacements et exceptions pour la langue:  |Frangais (France) ~ |
Remplacer Exceptions Options Options linguistiques

Remplacer Par: Texte seulement

[_a o Mouveau

. o N

A A :

— Supprimer

b B PP

_B B

_d )

_D A

_e £

_E E

__&vénement _Evénement

_f P

_F @

-4 ¥

_G r

_h n

_H H

i L

_ I

_ e

_ ] W

Aide OK Annuler Réinitialiser

Figure 26 : La boite de dialogue AutoCorrection

Remplacer

Editez la table de remplacement pour la correction automatique ou le remplacement de mots ou
d’abréviations dans votre document.
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Exceptions

Précisez les abréviations ou combinaisons de lettres que vous ne voulez pas que LibreOffice cor-
rige automatiquement.

Options
Sélectionnez les options pour la correction des erreurs en cours de frappe puis cliqguez sur OK.

Options linguistiques
Spécifiez les options d’autocorrection des guillemets et d’autres options particuliéres a la langue
utilisée pour les textes.

Réinitialiser

Rétablit les valeurs par défaut définies par LibreOffice.

-
" Attention

Les options d’AutoCorrection sont communes a tous les modules : les modifier dans
Calc, les modifiera aussi dans Writer ou Impress par exemple.

Désactiver les modifications automatiques

Changements de I’AutoCorrection
Voir « Options d’autocorrection » ci-dessus.

AutoSaisie

Quand vous tapez du texte dans une cellule, Calc suggere automatiquement une occurrence trou-
vée dans la méme colonne. Pour activer ou désactiver I'’AutoSaisie, affichez ou enlevez une coche
devant Outils > AutoSaisie.

Conversion automatique des dates

Calc convertit automatiquement certaines saisies en dates. Pour s’assurer qu'une saisie qui res-
semble a une date est considérée comme un texte, formatez la cellule en texte ou tapez une apos-
trophe au début de la saisie.

Accélérer la saisie des données

La saisie de données dans un classeur peut demander beaucoup de travail, mais Calc fournit plu-
sieurs outils pour en alléger certaines corvées.

La fonctionnalité la plus simple est de faire glisser et déposer le contenu d’'une cellule dans une
autre avec la souris. Beaucoup de personnes trouvent également utile I'AutoSaisie. Calc recéle
€galement plusieurs autres outils pour la saisie automatique, plus particulierement pour les taches
répétitives. Ce sont I'outil Remplir, les listes de sélection et la possibilité de saisir de I'information
dans plusieurs feuilles du document.

Utiliser I'outil Remplir dans les cellules

L'outil Remplir de Calc permet de dupliquer le contenu existant ou de créer une suite dans une
suite de cellules de votre classeur (Figure 27).

1) Sélectionnez la cellule qui contient ce que vous désirez copier ou I'amorce de la série.
2) Tirez la souris dans n’'importe quelle direction ou appuyez sur la touche Maj et cliquez sur
la derniére cellule que vous voulez remplir.
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3) Sélectionnez Feuille > Remplir les cellules dans la barre de menu et sélectionnez la
direction dans laquelle vous voulez copier ou créer les données (Vers le bas, A gauche,
Vers le haut, A gauche), Séries, ou Nombre aléatoire dans le sous-menu.

ATAB v fx X |anae v fx X |anas vl fx X
B B

Figure 27 : Utiliser l'outil Remplir

Vous pouvez aussi utiliser un raccourci pour remplir les cellules.

1) Sélectionnez la cellule qui contient ce que vous désirez copier ou I'amorce de la série.

2) Déplacez le pointeur sur le petit carré en bas a droite de la cellule sélectionnée. Le pointeur
change de forme.

3) Cliquez et tirez dans la direction ou vous désirez remplir les cellules. Si la cellule initiale
contenait du texte, celui-ci sera automatiquement recopié. Si la cellule initiale contenait un
nombre (seul ou en fin de chaine), une suite croissante sera créée si vous tirez vers la
droite ou vers le bas, décroissante si vous tirez vers la gauche ou vers le haut.

4) Si la cellule initiale contient un nombre et que vous appuyez simultanément sur la touche
Ctrl, son contenu est recopié au lieu d’étre incrémenté ou décrémenté.

Utiliser des séries de remplissage

Quand vous choisissez Feuille > Remplir les cellules > Série dans la barre de menu, la boite de
dialogue Rempilir la série s’ouvre (Figure 28). Vous pouvez y sélectionner le type de série que vous

voulez.
Rermplir la série “

Direction Type de séries Unité de temps
(®) Bas (®) Arithmétique Jour oK
Droite ) Geométrique lour de la semaine P
() Haut () Date Mois
Gauche () Rernplir automatiquement Année Aide

Valeur initiale : 32|
Valeur finale :

Incrément : 1

Figure 28 : La boite de dialogue Remplir la série

» Direction — définit la direction dans laquelle la suite est créée.

— Bas — crée une suite du haut vers le bas de la zone de cellules sélectionnées en utili-
sant I'incrément défini jusqu’a la valeur finale.
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— Droite — crée une suite de gauche a droite dans la zone de cellules sélectionnées en
utilisant I'incrément défini jusqu’a la valeur finale.

— Haut - crée une suite du bas vers le haut dans la zone de cellules sélectionnées en uti-
lisant I'incrément défini jusqu’a la valeur finale.

— Gauche — crée une suite de droite a gauche dans la zone de cellules sélectionnées en
utilisant 'incrément défini jusqu’a la valeur finale.

Type de séries — définit le type de la suite.

— Arithmétique — crée une suite arithmétique en ajoutant l'incrément a la valeur précé-
dente jusqu’a la valeur finale définie.

— Géométrique — crée une suite géométrique en multipliant la valeur précédente par I'in-
crément jusqu’a la valeur finale définie.

— Date — crée une suite de dates en ajoutant I'incrément a la date précédente jusqu’a la
date finale définie, compte tenu de I'unité de temps définie.

— Remplir automatiquement — crée une suite directement dans la feuille. La fonction de
remplissage automatique prend en compte les listes personnalisées. Par exemple, si
vous saisissez janvier dans la premiere cellule, la suite est complétée a partir de la liste
définie dans Outils > Options > LibreOffice Calc > Listes de tri (Figure 29). Le rem-
plissage automatique essaie de déterminer les valeurs d'une suite en définissant un
incrément arithmétique. Par exemple, une suite numérique commencant par 1, 3, 5 est
automatiquement complétée par 7, 9, 11, 13; une suite de date commencant par
01/01/99 et 16/01/99 sera complétée par des dates espacées de quinze jours.

Unité de temps — vous pouvez y spécifier I'unité de temps désirée. La zone n’est active
gue si l'option Date a été cochée dans la zone Type de série.

— Jour — utilisez le type de série Date et cette option pour créer une suite utilisant les sept
jours de la semaine.

— Jour de la semaine — utilisez le type de série Date et cette option pour créer une suite
utilisant cing jours ouvrables (du lundi au vendredi).

— Mois — utilisez le type de série Date et cette option pour créer une suite dont I'incrément
est en mois.

— Année — utilisez le type de série Date et cette option pour créer une suite dont l'incré-
ment est en années.

Valeur initiale — définit la valeur initiale de la suite. Utilisez des nombres, des dates ou des
heures.

Valeur finale — définit la valeur finale de la suite. Utilisez des nombres, des dates ou des
heures.

Incrément — définit la valeur par laquelle les éléments de la suite du type sélectionné sont
modifiés a chaque étape. La valeur ne peut étre saisie que si le type de série arithmétique,
géométrique ou date a été sélectionné.

Définir une liste de remplissage
Pour définir vos propres listes de remplissage :

1)

2)
3)
4)
5)

Sélectionnez Outils > Options > LibreOffice Calc > Listes de tri pour ouvrir la boite de
dialogue Listes de tri (Figure 29). Celui-ci affiche les suites définies précédemment dans la
boite Listes a gauche et le contenu de la liste sélectionnée dans la boite Entrées.

Cliquez sur Nouveau et la boite Entrées se vide.

Tapez la suite de la nouvelle liste dans la boite Entrées (une valeur par ligne).

Cliquez sur Ajouter et la nouvelle liste apparait désormais dans la zone Listes.

Cliquez sur OK pour enregistrer la nouvelle liste.
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Options - LibreQffice Calc - Listes de tri “

ODEEHBE

HEEHBE

LibreOffice

Chargement/enregistrement . .
Paramétres linguistiques lun.,mar, mer. jeu.,ven. sam.dim. Jun.

LibreOffice Calc lundi,mardi,mercredi jeudi vendredi same | mar.

LibreOffice Baze
Diagrammes
Internet
WriterZuhtml

Listes Entrées
MNouveau

- . . A, . Ajouter
Général anv, févr, mars,avr., maijuin,juil, aolt,sep[ |MEr Y

Par défaut janvier,février,mars,avril, mai juin,juillet,ac Jeu.
Affichage Ven.
Calcul sam.
Farmule dim.
Modifications
Compatibilité
Grille
Impression

Supprimer

Copier |a liste depuis: | SFeuillel,5)522 Copier

Aide Annuler Rétablir

Figure 29 : La boite de dialogue Listes de tri

Définir une liste de remplissage a partir d’une plage d’une feuille
Vous pouvez définir une liste de remplissage a partir d’'une plage de valeurs textuelles.

1)
2)

3)

Sélectionnez la plage qui contient les valeurs de texte que vous désirez utiliser comme liste
de remplissage.

Sélectionnez Outils > Options > LibreOffice Calc > Listes de tri pour ouvrir la boite de
dialogue Listes de tri (Figure 29).

La plage sélectionnée se trouve dans la boite Copier la liste depuis. Cliquez sur Copier
pour ajouter les valeurs aux listes de tri.

Utiliser les listes de sélection

Les listes de sélection sont disponibles uniqguement pour les textes et sont limitées a l'usage de
textes qui ont été déja saisis dans la méme colonne.

Pour utiliser une liste de sélection :

1)

2)

Sélectionnez une cellule vide dans une colonne contenant déja des entrées textuelles et
appuyez sur Alt+| (fleche bas) ou faites un clic droit et choisissez Liste de sélection.
Une liste déroulante apparait, contenant toutes les cellules de la méme colonne qui ont au
moins un caractéere de texte ou dont le format est défini comme texte. Les textes des cel-
lules sont triés par ordre alphabétique et ceux qui ont des occurrences multiples n’appa-
raissent qu’une seule fois.

Cliquez sur I'entrée dont vous avez besoin pour que le texte s'insére dans la cellule sélec-
tionnée.
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Partager du contenu entre différentes feuilles

Vous pouvez vouloir entrer la méme information dans la méme cellule de plusieurs feuilles, par
exemple pour fixer des listes standard pour un groupe de personnes ou pour des organismes. Au
lieu de saisir la liste individuellement dans chaque feuille, vous pouvez la saisir en une fois pour
toutes les feuilles. Pour ce faire,

1) Sélectionnez Feuille > Sélectionner des feuilles dans la barre de menu pour ouvrir la
boite de dialogue Sélectionner des feuilles.

| Feuilles sélectionnées

Feuillel | '
Feuille3 '
Aide QK Annuler

Figure 30 : La boite de dialogue Sélectionner des feuilles
2) Sélectionnez les feuilles ou vous désirez que I'information soit répétée. Utilisez les touches
Maj et Ctrl (Options sur Mac) pour sélectionner plusieurs feuilles.
3) Cliquez sur OK pour sélectionner les feuilles dont les onglets changent de couleur.

4) Saisissez l'information dans la feuille courante, elle sera répétée dans toutes les feuilles
sélectionnées.

-
" Attention

Cette technique écrase toute information qui se trouve déja dans les cellules des
autres feuilles, sans aucun avertissement. Pour cette raison, quand vous avez fini,
assurez-vous de bien désélectionner toutes les feuilles sauf celle que vous voulez
madifier. (Ctr1+clic sur un onglet pour sélectionner ou désélectionner la feuille.)

Valider le contenu des cellules

Quand vous créez des classeurs destinés a étre utilisés par d’autres personnes, vous pouvez vou-
loir vous assurer qu'elles saisissent des données qui sont valides ou appropriées pour la cellule.
Vous pouvez également utiliser la validation pour votre propre usage comme guide pour saisir des
données complexes ou rarement utilisées.

Les séries de remplissage et les listes de sélection peuvent convenir pour certains types de don-
nées, mais elles sont limitées aux informations prédéfinies. Pour valider une nouvelle donnée sai-
sie par un utilisateur, sélectionnez une cellule et utilisez Données > Validité sur la barre de menu
pour définir le type de contenu qui peut étre saisi dans cette cellule. Par exemple, une cellule peut
nécessiter une date ou un nombre entier, sans caractére alphabétique ni point décimal ; ou bien
encore une cellule ne doit pas étre laissée vide.
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Selon le paramétrage de la validation, I'outil peut aussi définir l'intervalle des valeurs qui peuvent
étre saisies, et fournir des messages d’aide qui expliquent les regles de validation que vous avez
paramétrées pour cette cellule (ce que les utilisateurs devraient faire s'ils saisissent un contenu
incorrect). Vous pouvez aussi paramétrer la cellule pour refuser un contenu incorrect, I'accepter
avec un avertissement, ou, si vous étes trés organisé, exécuter une macro si une erreur est saisie.

Pour plus d’informations sur cette fonctionnalité, voir le chapitre 2, Saisir, éditer et formater des
données dans le Guide Calc.

Modifier les données

Supprimer les données d’une cellule

Supprimer seulement les données

Les données seules peuvent étre supprimées dans une cellule sans affecter le formatage de la
cellule. Cliguez dans la cellule pour la sélectionner et appuyez ensuite sur la touche Suppr.

Supprimer les données et le formatage
Les données et le formatage peuvent étre supprimés d’une cellule en une seule fois.

1) Cliquez sur la cellule pour la sélectionner.

2) Appuyez sur la touche Retour arriére (ou faites un clic droit et choisissez Effacer le
contenu, ou utilisez Feuille > Effacer des cellules) pour ouvrir la boite de dialogue Sup-
primer du contenu (Figure 31). Dans cette boite de dialogue, plusieurs attributs de la cellule
peuvent étre supprimés. Pour tout supprimer dans une cellule (contenu et format), cochez

Tout supprimer.
Supprimer du contenu n

Sélection

[«] Texte [+] Mombres
[] Date & heure [+] Fermules
Commentaires [] Farmats
] Ohjets
Aide QK Annuler

Figure 31 : La boite de dialogue Supprimer du contenu

Remplacer toutes les données dans une cellule

Pour supprimer les données et insérer de nouvelles données, tapez simplement par-dessus les
anciennes données. Les nouvelles données conserveront le format des précédentes.

Vous pouvez aussi cliquer dans la ligne de saisie de la barre de formule (Figure 1 page 10), puis
faire un triple clic sur les données pour les sélectionner totalement et taper les nouvelles données.

Modifier les données dans une cellule

Il est parfois nécessaire de changer le contenu d’'une cellule sans en supprimer tout le contenu,
par exemple quand la phrase “Jean va partir” se trouve dans une cellule et doit étre changée en
“Jean va partir demain.” Il est souvent utile de le faire sans tout d’abord supprimer I'ancien contenu
de la cellule.
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Utiliser le clavier
1) Sélectionnez la cellule désirée en cliquant a l'intérieur.
2) Appuyez sur la touche F2 et le curseur sera placé a la fin de la cellule.
3) Utilisez alors les fleches du clavier pour déplacer le curseur dans le texte de la cellule a la
position ou débute la modification.
4) Appuyez sur la touche Entrée quand vous avez terminé pour enregistrer vos modifica-
tions.

Utiliser la souris
Vous pouvez soit
1) Double-cliquez dans la cellule voulue (pour la sélectionner et placer le curseur a l'intérieur
pour modification).

2) Cliquer dans la cellule pour placer le curseur a I'endroit ou vous désirez commencer les
modifications et effectuer celles-ci.

Ou bien

1) Cliguez pour sélectionner la cellule.
2) Déplacez le pointeur de la souris dans la ligne de saisie (Figure 1 page 10) et cliquez a I'in-
térieur pour placer le curseur pour modification.

Quand vous avez terminé, cliquez hors de la cellule pour la désactiver et enregistrer vos modifica-
tions.

Formater les données

“ Remarque
Tous les paramétrages abordés dans cette section peuvent aussi étre effectués en
tant qu’éléments d'un style de cellule. Voir le chapitre 4, Utiliser les styles et les
modeéles, du Guide Calc pour plus d’'informations.

Formater plusieurs lignes de texte

Des lignes de texte multiples peuvent étre saisies dans une seule cellule en utilisant le renvoi a la
ligne automatique ou des retours manuels a la ligne. Chaque méthode est utile dans différentes
situations.

Utiliser le retour a la ligne automatique

Méthode 1
Pour que le texte revienne a la ligne en fin de cellule,

1) Ouvrez la boite de dialogue Formatage des cellules par 'une des méthodes suivantes :

— faites un clic droit et sélectionnez Formater les cellules dans le menu contextuel
— choisissez Format > Cellules depuis la barre de menu,
— appuyez sur Ctrl+1.

2) Cliquez sur I'onglet Alignement (Figure 32),
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Formatage des cellules

Nombres Police Effets de caractére Alignement Bordures Arriére-plan Protection de cellule

Alignement du texte

Horizontal

Retr.

Par défaut

~| |0pt

Orientation du texte

vl L.
L s, Degrés :
& . 0 =
- ABCD e
% ~  Bord de référence :
e
/’f o \\ D O

Propriétés
M Renvoi 4 la ligne automatique:

1 Coupure des mots active

Ajuster a |a taille de la cellule

ait Vertical

- |Par défaut

LI Empilé verticalement

Direction du texte :

Utiliser les paramétres de I'objet supérieur |~

Figure 32 : La boite de dialogue Formatage des cellules, onglet Alignement

3) Sous Propriétés, cochez Renvoi a la ligne automatique et cliguez sur OK. Le résultat est
montré ci-dessous (Figure 33).

Cette cellule est paramétrée pour ne pas avoir de renvoi a la ligne automatique. Le texte continue L.
Cette cellule est paramétrée avec un

renvoi A la ligne automatique. La cellule

contient un texte important sans devenir

plus large.

Figure 33 : Retour a la ligne automatique

Méthode 2
1) Sélectionnez la cellule.

2) Ouvrez le Volet latéral (Affichage > Volet latéral), activez la page Propriétés et cliquez
sur I'icdne (+) d’ouverture du panneau Alignement pour ouvrir celui-ci.
3) Cochez Ajuster le texte pour appliquer immédiatement le formatage.

Eetrait :

=]

pt

o

=l Alignement

i

4k

Qrientation du texte :

=

] Fusionner les cellules

Ajuster le texte

o |v| [&|zo

[ ] Empilé verticalement

Figure 34 : Formatage du retour a la ligne.
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Utiliser les sauts de ligne manuels

Pour insérer un saut de ligne manuel pendant la frappe dans une cellule, appuyez sur
Ctrl+Entrée. Pour insérer un saut de ligne dans un texte déja saisi, double-cliquez dans la cel-
lule a I'endroit ou vous voulez faire un saut de ligne (il est aussi possible de cliquer dans la ligne de
saisie a I'endroit concerné) avant d’appuyer sur Ctrl1+Entrée.

Quelle que soit la méthode (renvoi a la ligne automatique ou saut de ligne manuel), la hauteur de
ligne est adaptée mais la largeur de cellule ne change pas. La Figure 35 montre le résultat de la
saisie de deux sauts de ligne manuels aprés la premiére ligne de texte. Vous devez modifier
manuellement la largeur de la cellule ou repositionner votre saut de ligne pour que votre texte ne
déborde pas de la fin de la cellule.

Cette ligne contient des sauts de ligne manuels.

Les lignes peuvent &tre espacées de cette facon.
Et la largeur de cellule n'est pas modifiée.

Figure 35 : Cellule avec sauts de ligne manuels

Ajuster le texte a la taille de la cellule

La taille de police des données d’'une cellule peut étre automatiquement ajustée pour remplir la
cellule. Pour le faire, cochez I'option Ajuster a la taille de la cellule dans la boite de dialogue For-
matage des cellules (Figure 32) dans l'onglet Alignement. La Figure 36 montre le résultat. Cette
boite de dialogue est aussi accessible en cliquant sur le bouton Plus d’options dans la barre titre
Alignement de I'onglet Propriétés du Volet latéral.

La taille de police s'ajuste 3 la cellule  iztmie oo poice s2me 2 12 02000 | a cone o0 mosce smprcms m cmie

Figure 36 : Ajustement de la taille de police a la cellule

Formater les nombres

Plusieurs formats de nombres différents peuvent étre appliqués aux cellules en utilisant les icones
de la barre d'outils Formatage (Figure 37). Sélectionnez la cellule, puis cliquez sur I'icbne corres-
pondante. Certaines icdnes peuvent ne pas étre visibles avec le réglage par défaut ; faites un clic
droit sur la barre puis choisir Boutons visibles et sélectionnez les icones a afficher.

- s
& % [T e+3 00 3% 75 X

Figure 37 : Icbnes de formats de nombres. De gauche a droite : monnaie, pourcentage,
date, scientifique, nombre, standard, ajouter une décimale, supprimer une décimale.

Pour plus de contrdle ou pour sélectionner d’'autres formats de nombres, utilisez I'onglet Nombres
(Figure 38) de la boite de dialogue Formatage des cellules :

* Appliquez 'un des types de données de la liste Catégorie aux donneées.

* Controlez le nombre de décimales et de zéros non significatifs dans Options.

* Saisissez une description de format personnalisée.

* Le paramétre Langue détermine les paramétres locaux pour les différents formats comme
I'ordre dans les dates et le symbole de I'unité monétaire.
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Formatage des cellules “
Mombres Police Effets de caractére Alignement Bordures Arriére-plan Protection de cellule
Catégorie Format Langue
Définiparl'utilisateur ] Standard Par déefaut - Fran;ai; (France) et
Nomore KDY
Pourcentage -1234.12
Monnaie -1234
Date 123412
Heure -1 3‘)‘l‘lr1
Scientifique
Fraction
Valeur logique 123457
Texte e
Options
MNombre de décimales: |2 = Mombres négatifs en rouge
Zéros non significatifs: |1 o Séparateur de milliers
Description de format
# #40,00;[RED]-# #£0,00 F

Figure 38 : La boite de dialogue Formatage des cellules, onglet Nombres

Certains formats numériques sont accessibles depuis le panneau Formats numériques du Volet
latéral dans I'onglet Propriétés (Figure 39). Cliquez sur le bouton Plus d’options I pour ouvrir

la boite de dialogue Formatage des cellules décrite ci-dessus.

= Format numérique &=

Mombre ~||.& % 00

Figure 39 : Icbnes de formats numériques dans le
panneau Format numérique du Volet latéral

Formater la police
Pour choisir rapidement la police utilisée dans une cellule :

1) Sélectionnez la cellule

2) Cliquez sur la fleche prés du champ Nom de police dans la barre d'outils Formatage
(Figure 40) et choisissez une police dans la liste.

3) Pour choisir la taille de la police, cliquez sur la fleche pres du champ Taille de police dans
la barre d’outils Formatage et choisissez une taille dans la liste.

Liberation Sans W |10 [ G ! i & - @ -

Figure 40 : Mise en forme du texte dans la barre d’outils Formatage

4) Pour d’autres attributs, vous pouvez utiliser les icones Gras, Italique ou Soulignage.

5) Pour modifier I'alignement du paragraphe, cliquez sur une des quatre icones d’'alignement
(Gauche, Centré, Droite, Justifié).

6) Pour choisir une couleur de police, cliqguez sur la fleche pres de I'icbne Couleur de police

& pour afficher la palette des couleurs. Cliquez sur la couleur voulue.
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Pour définir des couleurs personnalisées, utilisez Outils > Options > LibreOffice > Couleurs.
Voir le chapitre 14 du Guide Calc pour plus d'informations.

L'onglet Propriétés du Volet latéral posséde cing panneaux, Styles, Caractére, Alignement, For-
mat Numérique et Apparence de la cellule qui contiennent tous les contréles de mise en forme
de la barre d’outils Formatage.

Vous pouvez aussi utiliser le bouton Plus d’options = de I'un des panneaux du Volet latéral pour
ouvrir la boite de dialogue Formatage des cellules.
Pour spécifier la langue de la cellule (utile pour permettre a plusieurs langues d’exister dans un

méme document et d’étre vérifiées correctement (orthographe)), utilisez I'onglet Police de la boite
de dialogue Formatage des cellules.

Utilisez I'onglet Effets de caractére de la boite de dialogue Formatage des cellules pour définir
d’autres propriétés de la police. Voir le chapitre 4 du Guide Calc, Utiliser les styles et les modéles
dans Calc, pour plus d’informations.

Formater les bordures des cellules

Pour formater les bordures d'une cellule ou d’'un groupe de cellules sélectionnées, cliquez sur

l'icbne Bordures [ de la barre d’outils Formatage et choisissez une des options proposées par
la palette.
Pour choisir rapidement un style de ligne et une couleur pour les bordures d'une cellule, cliquez

sur la petite fleche pres des icones Style de bordure = et Couleur de bordure E dans la

barre d'outils Formatage pour afficher une palette Style de bordure ou Couleur de bordure. Si ces
icobnes ne sont pas affichées dans la barre d’outils Formatage, faites un clic droit sur la barre puis
choisissez Boutons visibles et sélectionnez les icbnes a afficher. Dans chaque cas, une palette
de choix est affichée.

Le panneau Apparence de cellule dans 'onglet Propriétés du Volet latéral contient les contrbles
Bordure de cellule, Style de ligne et Couleur de ligne.

Pour plus de contréle, comme I'espacement entre les bordures de la cellule et le texte, utilisez I'on-
glet Bordures de la boite de dialogue Formatage des cellules. La, vous pouvez également définir
un style d’'ombre.

Cliquer sur le bouton Plus d’options ' de la barre de titre Apparence de cellule ou sur Plus

d’options dans la liste déroulante style de ligne de ce panneau, ouvre la boite de dialogue Forma-
tage des cellules a la page Bordures ou vous pouvez aussi définir un Style d’'ombre.

Voir le chapitre 4 du Guide Calc, Utiliser les styles et les modeéles dans Calc, pour plus de détails.

e Remarque

Les propriétés de bordure de cellule s’appliquent a une cellule, et ne peuvent étre
modifiées que dans cette cellule. Par exemple, si la cellule C3 a une bordure haute (ce
gui est visuellement équivalent a une bordure basse dans C2), cette bordure ne
pourra étre supprimée qu’en sélectionnant C3. Elle ne pourra pas étre supprimée dans
C2.
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Formater l'arriere-plan des cellules

Pour choisir rapidement une couleur d’arriére-plan pour une cellule ou d’'un groupe de cellules, cli-

qguez sur la petite fleche prés de I'icone Couleur d’arriére-plan @ dans la barre d'outils Forma-
tage. Une palette de choix de couleurs, identique a la palette Couleur de police, est affichée.

Vous pouvez également utiliser I'onglet Arriére-plan de la boite de dialogue Formatage des cel-
lules.

Le panneau Apparence de cellule dans I'onglet Propriétés du Volet latéral contient un contrdle
Arriére-plan de cellule avec une palette de couleurs.

Pour définir des couleurs personnalisées, utilisez Outils > Options > LibreOffice > Couleurs.
Voir le chapitre 14 du Guide Calc pour plus d’informations.

Voir le chapitre 4 du Guide Calc, Utiliser les styles et les modéles dans Calc, pour plus de détails.

Formatage automatique des cellules

Utiliser I’AutoFormat

Vous pouvez utiliser la fonction AutoFormat de Calc pour mettre en forme rapidement et facilement
un groupe de cellules.

1) Sélectionnez les cellules que vous voulez formater dans au moins trois colonnes et trois
lignes, y compris les en-tétes de colonnes et de lignes.

2) Sélectionnez Format > Styles d’AutoFormat dans la barre de menu pour ouvrir la boite
de dialogue AutoFormat (Figure 41).

3) Choisissez le type et la couleur de formatage dans la liste.

4) Sélectionnez les propriétés de formatage a inclure dans la fonction AutoFormat.

5) Cliquez sur OK.

LAutoFormat “

Format

Par défaut S
3D .
m Janv.  Few. Mars  Total Annuler
Griz
laune
Lavande
Marron
Monnaie
Maonnaie 3D Sud 1 v = = Supprimer
Monnaie grise
Monnaie lavand Taul

| . [P U T —

< >

()
L
[
L]
o]
i
=
[

Eenommer

Formatage
[] Format numérique  [] Police  [~] Alignement
Bordures Motif Ajuster la largeur/hauteur

Figure 41 : La boite de dialogue AutoFormat
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Définir un nouvel AutoFormat

Vous pouvez définir un nouvel AutoFormat qui sera disponible pour tous les classeurs.

1)

2)
3)

4)
5)

6)

Mettez en forme le type de données, la police, sa taille, les bordures, I'arriére-plan, etc.
d’un groupe de cellules d’au moins 4 cellules sur 4.

Sélectionnez tout le tableau.

Sélectionnez Format > Styles d’AutoFormat pour ouvrir la boite de dialogue AutoFormat
ou le bouton Ajouter est maintenant actif.

Cliguez sur Ajouter.

Dans la zone Nom de la boite de dialogue Ajouter un AutoFormat qui s'ouvre alors, tapez
un nom significatif pour le nouveau format.

Cliquez sur OK pour I'enregistrer. Le nouvel AutoFormat est maintenant disponible dans la
liste Format de la boite de dialogue AutoFormat.

Utiliser les themes

Calc offre un ensemble prédéfini de thémes de formatage que vous pouvez appliquer aux clas-
seurs. |l n'est pas possible d’ajouter de nouveaux thémes a Calc ni de les modifier. Vous pouvez
toutefois changer leurs styles aprés les avoir appliqués a un classeur et ces styles modifiés ne
sont disponibles que pour celui-ci quand vous I'enregistrez.

Pour appliquer un théme a un classeur :

1)

: . @ : : :
Cliquez sur l'icone Sélectionner des themes = dans la barre d'outils Outils. Si celle-ci

n'est pas visible, sélectionnez Affichage > Barres d’outils dans la barre de menu et cli-
quez sur Outils. La boite de dialogue Sélection de théme s’ouvre (Figure 42). Il donne la
liste des themes applicables a 'ensemble du classeur.

Sélection de théme

(Standard) ~ !
Baignade

Be

Blue leans

Citrouille

Diner fifties

Feuilles d'automne

Glacier

Marine

Millénium

M drier

Mature

Moir et blanc

Mostalgie PC

Muit o

Figure 42 : La boite de dialogue Sélection de théme

2) Choisissez le théme que vous désirez appliquer. Des votre choix effectué, les styles du

theme sont appliqués au classeur et immédiatement visibles.

3) Cliquez sur OK.
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Si vous le souhaitez, vous pouvez alors ouvrir la fenétre Styles et Formatage pour modifier des
styles particuliers. Ces modifications ne changent pas le theme : elles ne font que changer I'appa-
rence du style dans le classeur précis que vous utilisez.

Utiliser le formatage conditionnel

Vous pouvez paramétrer le formatage des cellules pour qu’il change selon les conditions que vous
spécifiez. Par exemple, dans un tableau de nombres, vous pouvez afficher toutes les valeurs au-
dessus de la moyenne en vert et celles en dessous de la moyenne en rouge.

6 Remarque

Pour appliguer un formatage conditionnel, Calculer automatiquement doit étre activé.
Cochez Données > Calculer > Calculer automatiquement.

Ce paramétrage est accessible par le menu Format > Formatage conditionnel. Voir le chapitre 2
Entrer, modifier et formater des données du Guide Calc pour plus d'informations sur le formatage
conditionnel.

Masquer et afficher les données

Quand des éléments sont masqués, ils ne sont ni visibles ni imprimables, mais ils peuvent toujours
étre sélectionnés pour une copie si vous sélectionnez les éléments autour d’eux. Par exemple, si
la colonne B est masquée, elle est copiée si vous sélectionnez les colonnes A et C. Quand vous
avez a nouveau besoin d’'un élément masqué, vous pouvez inverser le processus et afficher I'élé-
ment.

Pour plus d’informations sur comment masquer/afficher des données, en particulier pour utiliser les
outils Plans et groupes, ou le filtrage de données, voir le chapitre 2, Entrer, modifier et formater
des données du Guide Calc.

Masquer et protéger des données
Pour masquer des lignes ou des colonnes :

1) Sélectionnez la ligne ou la colonne que vous voulez masquer.
2) Sélectionnez Format dans la barre de menu et cliqguez sur Ligne ou Colonne.
3) Choisissez Masquer dans le menu et la ligne ou la colonne n’est plus visible ni imprimée.

Vous pouvez aussi faire un clic droit sur I'en-téte de la ligne ou de la colonne et cliquer sur Mas-
quer (les lignes ou les colonnes) dans le menu contextuel.

Pour masquer des feuilles :

1) Sélectionnez les feuilles que vous voulez masquer.
2) Sélectionnez Feuille > Masquer les feuilles. Les feuilles ne sont plus visibles ni impri-
mées.

Vous pouvez aussi faire un clic droit sur I'onglet de la feuille et cliquer sur Masquer dans le menu
contextuel. Vous ne pouvez pas masquer toutes les feuilles d’'un classeur ; au moins une feuille
doit rester visible.

Pour masquer et protéger les données dans les cellules sélectionnées :

1) Sélectionnez Outils > Protéger la feuille. La boite de dialogue Protéger la feuille s'ouvre
(Figure 43).

2) Cochez Protéger cette feuille et le contenu des cellules verrouillées.

3) Saisissez un mot de passe (vous pouvez aussi le laisser vide) puis confirmez-le.

4) Cochez ou décochez les options de sélection des cellules par l'utilisateur.
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5) Cliquez sur OK.

Protéger la feuille “

Protéger cette feuille et le contenu des cellules verrouillées

Mot de passe: |

Confirmer :

Autariser tous les utilisateurs de cette feuille a :

Sélectionner les cellules non protégées

QK Annuler Aide

Figure 43 : La boite de dialogue Protéger la feuille

6) Sélectionnez les cellules que vous voulez masquer.
7) Ouvrez la boite de dialogue Formatage des cellules,

— en sélectionnant a Format > Cellules dans la barre de menu,

— en faisant un clic droit dans la cellule et en choisissant Formater les cellules dans le
menu contextuel,

— en utilisant le raccourci Ctrl+1 du clavier.

8) Cliguez sur I'onglet Protection des cellules (Figure 44) et choisissez une option masquer
les cellules.
9) Cliquez sur OK.

Formatage des cellules n

Mombres Police Effets de caractére Alignement Bordures Arriére-plané

Protection

[ Tout masquer La protection de cellule est effective uniquemnent
aprés que la feuille active a été protégée,
[ Protégé
Sélectionnez 'Protéger le docurnent’ & partir du

[] Masquer les formules menu 'Cutils’ et spécifiez 'Feuille'.
Imprimer
] Masquer pour l'impression Les cellules sélectionnées ne seront pas imprimeées,

Figure 44 : Page de Protection de cellule dans la boite de dialogue Formatage
des cellules

' Remarque

Quand les données d’une cellule sont masquées, la cellule vide reste visible dans le
classeur.

Afficher les données
Pour afficher les lignes et colonnes masquées :
1) Sélectionnez les lignes ou colonnes de chaque c6té de celles qui sont masquées.
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2) Sélectionnez Format dans la barre de menu puis Ligne ou Colonne.
3) Sélectionnez Afficher dans le menu et la ligne ou la colonne sera affichée et pourra étre
imprimée.
Vous pouvez aussi faire un clic droit sur I'en-téte de la ligne ou de la colonne et cliquer sur Affi-
cher (les lignes ou les colonnes) dans le menu contextuel.

Pour afficher des feuilles, sélectionnez Feuille > Afficher les feuilles et choisissez dans la liste
les feuilles que vous voulez de nouveau afficher. Les feuilles redeviendront visibles et seront impri-
mées.

Vous pouvez aussi faire un clic droit sur I'onglet d’'une feuille et cliquer sur Afficher dans le menu
contextuel pour afficher la méme liste ou vous pourrez choisir les feuilles a afficher de nouveau.

Pour afficher les données masquées dans les cellules :

1) Sélectionnez Outils > Protéger la feuille. La boite de dialogue Protéger la feuille s’ouvre.
2) Saisissez le mot de passe pour déverrouiller la feuille.

3) Cliquez sur OK.

4) Ouvrez la boite de dialogue Formatage des cellules,

— en sélectionnant & Format > Cellules dans la barre de menu,

— en faisant un clic droit dans la cellule et en choisissant Formater les cellules dans le
menu contextuel,

— en utilisant le raccourci Ctrl+1 du clavier.

5) Cliquez sur I'onglet Protection des cellules (Figure 44) et décochez les options de mas-
guage des cellules.
6) Cliquez sur OK.

Trier des enregistrements

Le tri modifie la disposition des cellules dans la feuille. Dans Calc, vous pouvez utiliser simultané-
ment plusieurs critéres de tri, qui sont appliqués I'un aprés l'autre. Les tris sont pratiques quand
vous cherchez un élément particulier, et sont encore plus puissants combinés aux filtres.

De plus, le tri est souvent utile quand vous ajoutez de nouvelles données. Quand une liste est
longue, il est habituellement plus facile d’ajouter des données en bas de la feuille, plutét que d'in-
sérer des lignes a leur bonne place. Aprés avoir ajouté des données, vous pouvez les trier pour
mettre a jour la feuille.

Si les données sont disposées en colonne et comportent un en-téte au format texte, 5. 7z
vous pouvez utiliser le tri rapide. Pour ceci, mettez en surbrillance les cellules a trier, Iau? n@
puis cliquez sur les boutons de barre d’outils Tri croissant ou Tri décroissant.

Pouir trier les cellules de votre classeur :

1) Sélectionnez les cellules a trier.
2) Sélectionnez Données > Trier dans la barre de menu pour ouvrir la boite de dialogue Trier
(Figure 45).
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Trier -
Critéres de tri Options
Clé de trit
(® Croiszant
() Décroissant
Clé de tri2
- (® Croissant
|Prennms V| ]
) Décroissant
Clé de tri3
Croizsant
|h-"||:|}f.-'r|:|:|ef V| @:]_? _
() Décroissant
Clé de trid
Croissant
- indéfini - v @c _
() Décroissant
Aide QK Annuler Eéinitialiser

Figure 45 : La boite de dialogue Criteres de tri

3) Sélectionnez les critéres de tri dans les listes déroulantes. Celles-ci sont remplies a partir
des cellules sélectionnées.

4) Cochez soit un tri ascendant (1-9, A-Z) soit un tri descendant (Z-A, 9-1).

5) Cliquez sur OK pour que le tri soit effectué sur la feuille de calcul.

Pour plus d’informations sur les options de tri, voir le chapitre 2, Entrer, modifier et formater des
données du Guide Calc.

Utiliser les formules et les fonctions

Vous allez sans doute avoir besoin de plus que du texte et des nombres dans votre feuille de cal-
cul. Souvent le contenu d'une cellule dépend du contenu d’autres cellules. Calc permet de faire
des calculs, des plus simples aux plus complexes en utilisant des formules. Les formules sont des
équations qui utilisent des opérateurs, des fonctions, des nombres et des variables pour produire
un résultat. Les variables font référence a des cellules qui contiennent les données nécessaires
aux équations.

Pour entrer une formule commencer par saisir le symbole égal (=). Par exemple pour calculer en
A3 la différence entre Al et A2 :

e Sélectionnez A3.

* Saisissez le symbole = ou cliquez sur le bouton Fonction de la barre de formule = .

» Saisissez A1-A2 (en minuscules ou majuscules) ou utilisez la souris :

— cliguez dans la cellule A1 (la référence apparait dans la formule) ;
— saisissez le symbole - pour calculer une différence ;
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— cliguez dans la cellule A2 (la référence apparait dans la formule).
* Validez par la touche Entreée.

La formule finale doit étre :
=A1-A2
La cellule A3 affiche le résultat et la barre de formule affiche la formule comme sur la Figure 46.

Opérateurs principaux Symboles
Addition +
Soustraction -
Multiplication *
Division /
Elévation a la puissance ~ (touche Alt Gr+9)
A3 =] A & = =m-w
L B | c
E | 65,2
2 33,841
: 31 ,359[

Figure 46 : Résultat de la saisie de la formule

Outre les opérateurs listés ci-dessus, Calc dispose de fonctions. Une fonction est un calcul prédé-
fini saisi dans une cellule pour vous aider a analyser ou manipuler des données. La seule chose
gue vous avez a faire est d’'ajouter des arguments et le calcul est automatiquement fait pour vous.
Les fonctions vous aident a créer les formules nécessaires a l'obtention des résultats que vous
recherchez.

Par exemple, vous désirez faire la somme des cellules A1 a E1, avec I'opérateur + vous devez sai-
sir une formule du type :
=A1+B1+C1+D1+E1
Plus le nombre de cellules a additionner sera grand, plus longue et fastidieuse a écrire sera la for-
mule. LibreOffice permet de simplifier 'opération en utilisant la fonction SOMME qui demande uni-
guement I'adresse d’'une plage de cellules et non la liste de toutes les cellules. Par exemple :
=SOMME (A1:E1)
Référez-vous au chapitre 7, Formules et fonctions, du Guide Calc pour plus d’informations.

Analyser les données

Calc offre plusieurs outils pour vous aider a analyser les informations contenues dans les feuilles
de calcul, allant des fonctions pour copier et réutiliser les données, a celles permettant de créer
automatiquement des sous-totaux ou encore a faire varier I'information pour vous aider a trouver
les réponses que vous cherchez. Ces outils sont accessibles par le menu Données.

L'un des outils les plus utiles est la Table de pilote (ou Table dynamique). C’est un outil pour com-
biner, comparer et analyser facilement d'importantes quantités de données. En utilisant la table de
pilote, vous pouvez afficher differents sommaires de source de données, afficher les détails de
zone d'intéréts et créer des rapports, et ce que vous soyez un utilisateur débutant, intermeédiaire ou
confirmé. Référez-vous au chapitre 8, Utiliser la table de pilote, du Guide Calc pour plus d'informa-
tions.
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Calc propose aussi de nombreux outils d’analyse statistique des données qui vous permettent
d’'obtenir des informations numériques importantes sur les données provenant de mesures phy-
sigues, de sondages ou méme de transactions commerciales telles que des ventes, des cotations
boursiéres, etc. Ces analyses de données statistiques sont accessibles par le menu Données >
Statistiques.

Un autre outil d’'analyse de Calc est la possibilité de créer des diagrammes pour visualiser les don-
nées. Les possibilités offertes sont tres riches. Référez-vous au chapitre 3, Créer des diagrammes
et des graphiques, du Guide Calc pour plus d’'informations.

Impression

L'impression a partir de Calc est pratiquement la méme que I'impression a partir des autres com-
posants de LibreOffice (voir le chapitre 10, Impression, exportation, mailing, de ce guide) mais cer-
tains détails sont différents surtout en ce qui concerne la préparation a I'impression.

Utiliser les zones d’'impression

Les zones d’'impression ont plusieurs utilisations, elles permettent de n'imprimer qu’une partie spé-
cifique des données ou de lignes ou colonnes sélectionnées sur chaque page. Pour plus d’infor-
mations sur les zones d'impression, voir le chapitre 6, Impression, exportation, mailing du Guide
Calc.

Définir une zone d’impression
Pour définir une nouvelle zone d’impression ou modifier une zone d'impression existante :

1) Sélectionnez la plage de cellules qui compose la zone d’'impression.

2) Choisissez Format > Zones d’impression > Définir. Les lignes de délimitation des pages
s’affichent a I'écran.

3) Vous pouvez vérifier la zone d’impression en utilisant Fichier > Apercu ou en cliquant sur

l'icbne Apercu \j% LibreOffice n'affichera que les cellules a l'intérieur de la zone d'impres-

sion.

> Conseil

Le mode Affichage > Apercu des sauts de page permet également de facilement
repérer la zone d’impression sans passer par I'apercu avant impression.

Ajouter une plage a la zone d’impression

Aprés avoir défini une zone d’impression, vous pouvez lui ajouter des cellules supplémentaires.
Ceci permet d’'imprimer plusieurs zones séparées dans la méme feuille, sans avoir a imprimer la
feuille en entier.

Apres avoir défini une zone d’'impression :

1) Sélectionnez la plage de cellules a ajouter a la zone d’impression.

2) Choisissez Format > Zones d’impression > Ajouter. Les cellules supplémentaires sont
alors ajoutées a la zone d’impression.

3) Vous pouvez vérifier la zone d'impression en utilisant Fichier > Apercu. Ou cliquer sur

l'icone Apercu & LibreOffice n’affichera que les cellules a l'intérieur de la zone d’impres-

sion.

Les lignes de délimitation des pages ne s’affichent plus a I'écran.
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e Remarque

La zone d'impression supplémentaire sera imprimée sur une page séparée, méme si
les deux zones sont sur la méme feuille.

Supprimer une zone d’impression
Il peut devenir nécessaire de supprimer une zone d’impression définie, s'il faut imprimer la feuille
entiére par exemple.

Choisissez Format > Zones d’'impression > Effacer. Ceci va supprimer toutes les zones d’'im-
pression définies dans la feuille. Une fois la zone d’'impression supprimée, les lignes de délimita-
tion de page par défaut s'afficheront de nouveau a I'écran.

Editer une zone d’impression

A tout moment vous pouvez éditer directement la zone d'impression par exemple pour supprimer
ou redimensionner une partie de la zone. Choisissez Format > Zones d’impression > Editer pour
ouvrir la boite de dialogue Editer les zones d’impression ou vous pouvez définir celles-ci.

Options d’impression
Pour sélectionner 'ordre des pages, les détails et I'échelle :

1) Choisissez Format > Page a partir du menu principal
2) Dans la boite de dialogue Style de page (Figure 47), sélectionnez I'onglet Feuille.
3) Faites votre sélection et cliguez ensuite sur OK.

Pour plus d’informations sur les options d'impression, voir le chapitre 6, Impression, exportation,
mailing du Guide Calc.

Style de page: Par défaut

Gestionnaire Page Bordures Arriére-plan En-téte Pied de page Feuille

Ordre des pages

@®De haut en bas, puis vers la droitei

O De gauche & droite, puis vers le bas

Premier numéro de page : 1 =

Imprimer

[] En-tétes de colonne et de ligne
O Grille

[ Commentaires

M Objets/images

Echelle

Diagrammes
Objets de dessin
O Formules

I Valeurs zéro

Mode d'échelle: |Réduire/agrandir I'impression

Facteur d'échelle:  |100 % -

Aide

Réinitialiser

Figure 47 : Onglet Feuille de la boite de dialogue Style de page
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Imprimer des lignes ou colonnes sur chaque page

Si une feuille s'imprime sur plusieurs pages, vous pouvez paramétrer le fait que certaines lignes ou
colonnes se répétent sur chaque page imprimée.

Par exemple, si les deux premiéres lignes, ainsi que la colonne A, doivent étre imprimées sur
toutes les pages, effectuez les opérations suivantes :

1) Choisissez Format > Zones d’impression > Editer. Dans la boite de dialogue Editer les
zones d'impression (Figure 48) saisissez les lignes dans la boite de saisie de texte sous
Lignes a répéter. Par exemple, pour répéter les lignes 1 et 2, tapez $1:$2. Cela va modi-
fier Lignes a répéter de — aucun - & — défini par I'utilisateur -.

2) Pour répéter des colonnes, saisissez-les dans la boite de saisie de texte sous Colonnes a
répéter. Par exemple, pour répéter la colonne A, tapez $A. Cela va modifier Colonnes a
répéter de — aucun - a — défini par l'utilisateur -.

3) Cliquez sur OK.

“ Remarque

Vous pouvez également sélectionner les lignes ou colonnes a répéter avec la souris.
Pour ceci, positionnez le curseur dans la zone de saisie de texte correspondante, puis
sélectionnez dans la feuille la plage de cellules désirée. Il n'est pas nécessaire de
sélectionner des lignes ou colonnes entiéres : une cellule de chaque ligne ou colonne
suffit.

N

Pour plus d'information sur I'édition des plages a imprimer, voyez le Guide Calc, Chapitre 6,
Impression, exportation, mailing.

Editer les zones d'impression n

Zones d'impression

- defini par 'utilisateur - |~ | SAS1:5BS8:5D51:5F58: 5A520:50523

Lignes a répéter

- défini par I'utilisateur - |~ | | §1:62

Colonnes a répéter

- défini par I'utilisateur -~ | |SA

Aide QK Annuler

Figure 48 : Définir des lignes a répéter

Sauts de page

Si la définition de zones d'impression peut étre un puissant outil, il est parfois nécessaire d'ajuster
manuellement I'impression dans Calc. Pour ceci, vous pouvez utiliser un saut de page manuel. Un
saut de page manuel vous aide a vous assurer que vos données vont s'imprimer correctement.
Vous pouvez insérer un saut de page horizontal au-dessus de la cellule active, ou un saut de page
vertical & gauche de celle-ci.

Pour plus d’informations sur les sauts de page manuels, voyez le chapitre 6, Impression, exporta-
tion, mailing du Guide Calc.
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Insérer un saut de page
Pour insérer un saut de page :

1) Activez la cellule ou le saut de page va commencer.
2) Sélectionnez Feuille > Insérer un Saut de page dans la barre de menu.
3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.

Le saut de page est alors paramétré.

Saut de ligne
Saut de ligne va créer un saut de page au-dessus de la cellule sélectionnée. Par exemple, si la
cellule active est H15, le saut de page est alors placé entre les lignes 14 et 15.

Saut de colonne
Saut de colonne va créer un saut de page a gauche de la cellule sélectionnée. Par exemple, si la
cellule active est H15, le saut de page est alors placé entre les colonnes G et H.

> Conseil

Pour voir plus facilement les sauts de page a I'écran, vous pouvez changer leur cou-
leur. Choisissez Outils > Options > LibreOffice > Couleurs de I'interface et faites
défiler la liste jusqu’a la section Classeur.

Supprimer un saut de page
Pour supprimer un saut de page :

1) Activez la cellule prés du saut de page a supprimer.
2) Sélectionnez Feuille > Supprimer le saut de page dans la barre de menu.
3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.

Le saut de page est alors supprimé.

“ Remarque

Plusieurs sauts de ligne et de colonne manuels peuvent exister dans la méme feuille.
Si vous voulez les supprimer, vous devez supprimer chaque saut individuellement
(voir I'astuce suivante). Cela peut parfois étre difficile, car bien qu’il puisse y avoir un
saut de colonne paramétré dans la feuille, quand vous sélectionnez Feuille > Suppri-
mer le saut de page, le choix Saut de colonne peut étre indisponible (grisé).

e Remarque

Pour supprimer le saut de page, vous devez étre dans la cellule & c6té de celui-ci. Par
exemple, si vous avez défini un saut de colonne alors que vous étiez en H15, vous ne
pouvez pas le supprimer si vous étes dans la cellule D15. Cependant, vous pouvez le
supprimer depuis n'importe quelle cellule de la colonne H.

> Conseil

Vous pouvez également utiliser I'option Supprimer tous les sauts manuels du menu
contextuel si vous avez sélectionné Affichage > Sauts de page.

En-tétes et pieds de page

Les en-tétes et pieds de page sont des éléments de texte prédéfinis qui sont imprimés respective-
ment en haut et en bas d'une page, en dehors de la zone de page. Les en-tétes et les pieds de
page fonctionnent de la méme fagon. Pour plus d'informations sur la création des en-tétes et des
pieds de page, voyez le chapitre 6, Impression, exportation, mailing du Guide Calc.
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Les en-tétes et les pieds de page sont dépendants des styles de page. Vous pouvez définir plus
d'un style de page dans un classeur et attribuer des styles de page différents aux différentes
feuilles. Pour plus d’informations sur ces styles, voyez le chapitre 4, Utiliser les styles et les
modéles dans Calc, du Guide Calc.

Définir un en-téte ou un pied de page
Pour paramétrer un en-téte ou un pied de page :

1) Sélectionnez la feuille dont vous voulez paramétrer I'en-téte ou le pied de page. Sélection-
nez Format > Page.

2) Sélectionnez l'onglet En-téte (Figure 49) (ou Pied de page) dans la boite de dialogue
Style de page.

3) Cochez I'option Activer I’en-téte (ou Activer le pied de page).

4) Cochez l'option Contenu identique gaucheldroite si vous voulez que le méme texte
apparaisse sur les pages de droite comme de gauche.

A ce stade, vous pouvez également paramétrer les marges, 'espacement et la hauteur de I'en-téte
ou du pied de page. Vous pouvez cocher la case Adaptation dynamique de la hauteur pour ajuster
automatiquement la hauteur de I'en-téte ou du pied de page.

Marges
La taille des marges gauche et droite ajuste la distance de I'en-téte ou du pied de page par
rapport aux cotés de la page.

Espacement
L'espacement détermine la distance au-dessus ou en dessous de la feuille a laquelle I'en-
téte ou le pied de page sera imprimé. Ainsi, si I'espacement est de 1 cm, il y aura un espace
de 1 cm entre la feuille et I'en-téte ou le pied de page.

Hauteur
La hauteur représente la taille de I'en-téte ou du pied de page.

Style de page: Par défaut n

Gestionnaire Page Bordures Arriere-plan En-téte Pied de page Feuille

Fied de page
Activer le pied de page
Contenu identique gauche/droite

Marge gauche: 000 cm =
Marge droite : 000 cm |5
Espacement : 025cm =
Hauteur: 050 cm =

Adaptation dynamigque de la hauteur

Plus...

Aide QK Annuler Reinitialiser

Figure 49 : Boite de dialogue Style de page — Pied de page

Pour modifier I'apparence de I'en-téte ou du pied de page, cliquez sur le bouton Plus, ce qui va
ouvrir la boite de dialogue Bordure / Arriere-plan. A partir de cette boite de dialogue, vous pouvez
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définir l'arriere-plan et la bordure de I'en-téte ou du pied de page. Pour plus d’informations, voir le
chapitre 4 Utiliser les styles et les modeles dans le Guide Calc.

Pour définir le contenu de I'en-téte ou du pied de page (numéro de page, date, etc.), cliquez sur le
bouton Editer dans la boite de dialogue de la Figure 49 afin d’afficher la boite de dialogue En-téte
(ou Pied de page). Pour plus d'informations, voyez le chapitre 6, Impression, exportation, mailing
du Guide Calc.

3

. Attention

Toutes les feuilles utilisant le méme style de page seront modifiées. Si vous souhaitez
des en-tétes et pieds de page différents suivant les feuilles, vous devez leur attribuer
des styles de page différents.
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